Agilent
Oligonucleotide
Array-Based CGH for
Genomic DNA Analysis

Bravo Automated Liquid
Handling Platform with
Enzymatic and ULS Labeling

Protocol

Version 1.1, November 2010

Agilent Technologies



Notices

© Agilent Technologies, Inc. 2009-2010

No part of this manual may be reproduced in
any form or by any means (including elec-
tronic storage and retrieval or translation

into a foreign language) without prior agree-

ment and written consent from Agilent
Technologies, Inc. as governed by United
States and international copyright laws.

Manual Part Number
G4410-90040

Edition
Version 1.1, November 2010

Agilent Technologies, Inc.
5301 Stevens Creek Blvd.
Santa Clara, CA 95051 USA

Technical Support

Technical product support may be obtained
by contacting your local Agilent Support
Services representative. Agilent’s world-
wide sales and support center telephone
numbers can be obtained at the following
web site under Contact Us:
www.genomics.agilent.com

or send an e-mail to:
genomics@agilent.com

Notice to Purchaser

This item is not approved for use in diag-
nostic procedures. User is responsible for
obtaining regulatory approval or clearance
from the appropriate authorities prior to
diagnostic use. Agilent Technologies shall
not be liable for errors contained herein or
for incidental or consequential damages in
connection with the furnishing, perfor-
mance, or use of this material.

Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice,
in future editions. Further, to the max-
imum extent permitted by applicable
law, Agilent disclaims all warranties,
either express or implied, with regard
to this manual and any information
contained herein, including but not
limited to the implied warranties of
merchantability and fitness for a par-
ticular purpose. Agilent shall not be
liable for errors or for incidental or
consequential damages in connec-
tion with the furnishing, use, or per-
formance of this document or of any
information contained herein. Should
Agilent and the user have a separate
written agreement with warranty
terms covering the material in this
document that conflict with these
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses

The hardware and/or software described in
this document are furnished under a license
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend

U.S. Government Restricted Rights. Soft-
ware and technical data rights granted to
the federal government include only those
rights customarily provided to end user cus-
tomers. Agilent provides this customary
commercial license in Software and techni-
cal data pursuant to FAR 12.211 (Technical
Data) and 12.212 (Computer Software) and,
for the Department of Defense, DFARS
252.227-7015 (Technical Data - Commercial
Items) and DFARS 227.7202-3 (Rights in
Commercial Computer Software or Com-
puter Software Documentation).

Safety Notices

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like
that, if not correctly performed or
adhered to, could result in damage
to the product or loss of important
data. Do not proceed beyond a
CAUTION notice until the indicated
conditions are fully understood and
met.

A WARNING notice denotes a
hazard. It calls attention to an
operating procedure, practice, or
the like that, if not correctly per-
formed or adhered to, could result
in personal injury or death. Do not
proceed beyond a WARNING
notice until the indicated condi-
tions are fully understood and
met.

Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform


www.agilent.com/chem/contactus
www.agilent.com/chem/dnasupport
mailto:genomics@agilent.com

In This Guide...

This guide describes Agilent's recommended operational procedures to
analyze DNA copy number variations using Agilent 60-mer oligonucleotide
microarrays for array-based comparative genomic hybridization (aCGH)
analysis. This protocol is specifically developed and optimized to use the
Bravo Automated Liquid Handling Platform for the labeling (ULS and
enzymatic), purification and pre-hybridization steps.

1 Before You Begin

This chapter contains information (such as procedural notes, safety
information, required reagents and equipment) that you should read and
understand before you start an experiment.

2 DNA Isolation

This chapter describes the method to isolate genomic DNA (gDNA) from blood,
cells, frozen tissues, or FFPE samples prior to labeling.

3 Sample Preparation for Bravo Platform

This chapter describes how to prepare the samples to be used on the Bravo
Automated Liquid Handling Platform.

4 DNA Labeling on the Bravo Platform

This chapter describes the fragmentation, labeling (ULS and enzymatic),
clean-up and preparation of labeled gDNA for hybridization done on the Bravo
platform.

b Microarray Processing and Feature Extraction

This chapter describes the steps to hybridize, wash and scan Agilent CGH
microarrays and to extract data using the Agilent Feature Extraction
Software.

6 Troubleshooting

This chapter contains the causes for above-threshold DLRSD (Derivative Log
Ratio Standard Deviation). A poor DLRSD score reflects high probe-to-probe
log ratio noise.
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7 Reference

This chapter contains reference information related to the protocol.

What's New in Version 1.1?

* Processing of 1x1M, 2x400K, 4x180K and 8x60K SurePrint G3 CGH+SNP
microarrays for enzymatic labeling is supported.

¢ Guidelines for gDNA Quantitation and Quality Analysis are expanded.

¢ Proteinase K step in DNA Isolation is lowered to 56°C.
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Before You Begin

Procedural Notes

Follow the procedure described in this document to isolate gDNA from
blood, cells, frozen tissues or FFPE samples.

If the DNA isolation procedure described in this document cannot be
followed, make sure that the DNA is free of RNA and protein contamination.
For ULS labeling, also make sure the DNA is in one of the following buffers
compatible with ULS labeling:

TE-buffer (10 mM Tris-HCl, 1 mM EDTA, pH 7.5 or pH 8)
10 mM LiCl

10 to 100 mM Na acetate

10 mM NacCl

To prevent contamination of reagents by nucleases, always wear
powder-free laboratory gloves, and use dedicated solutions and pipettors
with nuclease-free aerosol-resistant tips.

Maintain a clean work area.

Do not mix stock solutions and reactions containing gDNA or enzymes
on a vortex mixer. Instead, mix the solutions and reactions by gently
tapping the tube with your finger.

Avoid repeated freeze-thaw cycles of solutions containing gDNA or
enzymes.

When preparing frozen reagent stock solutions for use:

1 Thaw the aliquot as quickly as possible without heating above room
temperature.

2 Mix briefly on a vortex mixer, then spin in a microcentrifuge for 5 to
10 seconds to drive the contents off the walls and lid.

3 Store on ice or in a cold block until use.

In general, follow Biosafety Level 1 (BL1) safety rules.
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Before You Begin 1

Safety Notes

Wear appropriate personal protective equipment (PPE) when working in the laboratory.

ULS-Cy3, ULS-Cy5, Cyanine 3-dUTP and Cyanine 5-dUTP are considered
hazardous by the 0SHA Hazard Communication Standard (29 CFR 1910.1200).
Contains material that causes damage to the following organs: kidneys, liver,
cardiovascular system, respiratory tract, skin, eye lens or cornea, stomach. May
be harmful if swallowed. Avoid contact with eyes, skin and clothing.

2X Hi-RPM Hybridization Buffer is considered hazardous by the 0SHA Hazard
Communication Standard (29 CFR 1910.1200). Contains material that causes
damage to the following organs: skin, central nervous system. May be harmful if
swallowed. Avoid contact with eyes, skin and clothing.

Triton is harmful if swallowed. Risk of serious damage to eyes. Wear suitable
PPE. Triton is a component of Agilent’s 2X Hi-RPM Hybridization Buffer.

Agilent Stabilization and Drying Solution is considered hazardous by the 0SHA
Hazard Communication Standard (29 CFR 1910.1200). Flammable liquid and
vapor. Keep away from heat, sparks and flame. Keep container closed. Use only
with adequate ventilation. This solution contains material which causes damage
to the following organs: kidneys, liver, cardiovascular system, upper respiratory
tract, skin, central nervous system (CNS), eye, lens or cornea.

Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform 11



1

12

Before You Begin

Agilent Oligo CGH Microarray Kit Contents

Store entire kit at room temperature. After the microarray foil pouch is
opened, store the microarray slides at room temperature (in the dark) under a
vacuum desiccator or Ny purge box. Do not store microarray slides in open air
after breaking foil.

Catalog CGH Microarray Kits

¢ Five 1l-inch x 3-inch glass slides for 1x and 2x Microarray Kits
¢ Three 1-inch x 3-inch glass slides for 4x and 8x Microarray Kits

¢ Disk that contains microarray design files in various file formats
Design files can be downloaded from https://earray.chem.agilent.com/earray.

See Table 1 and Table 2 for available designs. For more information on CGH
designs, go to http://www.genomics.agilent.com. Under Products, click By
Application > Comparative Genomic Hybridization (CGH).

Table 1  Available Catalog SurePrint HD CGH Microarray Kits

Part Number Description

G4411B Human Genome CGH Microarray Kit 1x244K
G4412A Human Genome CGH Microarray Kit 2x105K
G4417A Human CNV Association Microarray Kit 2x105K
G4413A Human Genome CGH Microarray Kit 4x44K
G4415A Mouse Genome CGH Microarray Kit 1x244K
G4416A Mouse Genome CGH Microarray Kit 2x105K
G4435A Rat Genome CGH Microarray Kit 1x244K
G4436A Rat Genome CGH Microarray Kit 2x105K

Table 2  Available Catalog SurePrint G3 CGH Microarray Kits

Part Number Description
G4447A SurePrint G3 Human CGH Microarray Kit 1x1M
G4448A SurePrint G3 Human CGH Microarray Kit 2x400K
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Before You Begin 1
Table 2  Available Catalog SurePrint G3 CGH Microarray Kits (continued)
Part Number Description
G4449A SurePrint G3 Human CGH Microarray Kit 4x180K
G4450A SurePrint G3 Human CGH Microarray Kit 8x60K
G4506A SurePrint G3 Human High-Resolution Discovery Microarray 1x1M
G4507A SurePrint G3 Human CNV Microarray Kit 2x400K
G4838A SurePrint G3 Mouse CGH Microarray Kit 1x1M
G4839A SurePrint G3 Mouse CGH Microarray Kit 4x180K
G4840A SurePrint G3 Rat CGH Microarray Kit 1x1M
G4841A SurePrint G3 Rat CGH Microarray Kit 4x180K
G4842A SurePrint G3 Human CGH+SNP Microarray Kit 2x400K
G4890A" SurePrint G3 Human CGH+SNP Microarray Kit 4x180K
* These arrays can only be processed using the enzymatic labeling protocol.
Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform 13
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Before You Begin

Unrestricted SurePrint HD and G3 CGH Microarray Kits

* One, two, four or eight microarray(s) printed on each 1-inch x 3-inch glass

slide

¢ Number of microarrays varies per kit and per order

¢ Disk that contains microarray design files in various file formats

See Table 3 and Table 4 for available designs.

Table 3  Unrestricted High-Definition CGH Microarrays

Part Number Description
G4423B, AMADID 014693  Unrestricted HD-CGH Microarray, 1x244K, Human
(same design as G4411B)

G4423B, AMADID 016266
G4423B, AMADID 014695

G4423B, AMADID 015223

G4423B, AMADID 019553
G4425B, AMADID 014698

G4425B, AMADID 022837

G4425B, AMADID 014699

G4425B, AMADID 015235

G4426B, AMADID 014950

G4426B, AMADID 015028

Unrestricted HD-CGH Microarray, 1x244K supplemental, Human

Unrestricted HD-CGH Microarray, 1x244K, Mouse
(same design as G4415A)

Unrestricted HD-CGH Microarray, 1x244K, Rat
(same design as G4435A)

Unrestricted HD-CGH Microarray, 1x244K, Chicken

Unrestricted HD-CGH Microarray, 2x105K, Human
(same design as G4412A)

Unrestricted HD-CGH Microarray, 2x105K, Human
(same design as G4417A)

Unrestricted HD-CGH Microarray, 2x105K, Mouse
(same design as G4416A)

Unrestricted HD-CGH Microarray, 2x105K, Rat
(same design as G4436A)

Unrestricted HD-CGH Microarray, 4x44K, Human
(same design as G4413A)

Unrestricted HD-CGH Microarray, 4x44K, Mouse
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Unrestricted SurePrint G3 CGH Microarrays

Part Number

Description

G4824A, AMADID 021529

G4824A, AMADID 023642

G4824A, AMADID 027414

G4824A, AMADID 027065

G4825A, AMADID 021850

G4825A, AMADID 021365

G4826A, AMADID 022060

G4826A, AMADID 027411

G4826A, AMADID 027064

G4826A, AMADID 024422
G4826A, AMADID 024419
G4826A, AMADID 025242
G4826A, AMADID 025522
G4826A, AMADID 025843
G4827A, AMADID 021924

Unrestricted SurePrint G3 CGH Microarray, 1x1M, Human
(same design as G4447A)

Unrestricted SurePrint G3 CGH Microarray, 1x1M, Human
(same design as G4506A)

Unrestricted SurePrint G3 CGH Microarray, 1x1M, Mouse (same
design as G4838A)

Unrestricted SurePrint G3 CGH Microarray, 1x1M, Rat (same design as
G4840A)

Unrestricted SurePrint G3 CGH Microarray, 2x400K, Human
(same design as G4448A)

Unrestricted SurePrint G3 CGH Microarray, 2x400K, Human
(same design as G4507A)

Unrestricted SurePrint G3 CGH Microarray, 4x180K, Human
(same design as G4449A)

Unrestricted SurePrint G3 CGH Microarray, 4x180K, Mouse (same
design as G4839A)

Unrestricted SurePrint G3 CGH Microarray, 4x180K, Rat (same design
as G4841A)

Unrestricted SurePrint G3 CGH Microarray, 4x180K, Chimpanzee
Unrestricted SurePrint G3 CGH Microarray, 4x180K, Rhesus Macaque
Unrestricted SurePrint G3 CGH Microarray, 4x180K, Bovine
Unrestricted SurePrint G3 CGH Microarray, 4x180K, Canine
Unrestricted SurePrint G3 CGH Microarray, 4x180K, Rice

Unrestricted SurePrint G3 CGH Microarray, 8x60K, Human
(same design as G4450A)

Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform
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Before You Begin

Custom SurePrint HD and G3 Microarray Kits

* One, two, four or eight microarray(s) printed on each 1-inch x 3-inch glass
slide

¢ Number of microarrays varies per kit and per order

See Table 5 and Table 6 for available formats.

Table5  Custom High-Definition CGH Microarrays

Part Number Description

G4423A Custom HD-CGH Microarray, 1x244K
G4425A Custom HD-CGH Microarray, 2x105K
G4426A Custom HD-CGH Microarray, 4x44K
G4427A Custom HD-CGH Microarray, 8x15K

Table6  Custom SurePrint G3 CGH Microarrays

Part Number Description

G4123A SurePrint G3 Custom CGH Microarray, 1x1M
G4124A SurePrint G3 Custom CGH Microarray, 2x400K
G4125A SurePrint G3 Custom CGH Microarray, 4x180K
G4126A SurePrint G3 Custom CGH Microarray, 8x60K
G4882A° SurePrint G3 Custom CGH+SNP Microarray, 1x1M
G4883A" SurePrint G3 Custom CGH+SNP Microarray, 2x400K
GA884A SurePrint G3 Custom CGH+SNP Microarray, 4x180K
G4885A° SurePrint G3 Custom CGH+SNP Microarray, 8x60K

* These arrays can only be processed using the enzymatic labeling protocol.
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Before You Begin

Required Equipment

Table7  Required equipment

Description Company and part no.

For Enzymatic Labeling: Agilent p/n G5409A Option 002

Bravo Automated Liquid Handling Platform with 96 Channel
Disposable LT Pipetting Head, Riser and 2 CPAC Ultraflat
heated/cooled Deck Pads

For ULS labeling: Agilent p/n G5409A Option 003

Bravo Automated Liquid Handling Platform with 96 Channel
Disposable LT Pipetting Head

Robotic Pipetting Tips (250 pL) Agilent p/n 19477-002
Agilent Microarray Scanner Bundle
for 1x244K, 2x105K, 4x44K or 8x15K, or Agilent p/n G2565BA or G2565CA
for 1x1M, 2x400K, 4x180K or 8x60K Agilent p/n G2565CA
Hybridization Chamber, stainless Agilent p/n G2534A

Hybridization Chamber gasket slides, 5-pack (20 and 100
packaging sizes are available)

for 1x microarrays or Agilent p/n G2534-60003

for 2x microarrays or Agilent p/n G2534-60002

for 4x microarrays or Agilent p/n G2534-60011

for 8x microarrays Agilent p/n G2534-60014
Hybridization oven; temperature set at 65°C Agilent p/n G2545A
Hybridization oven rotator for Agilent Microarray Agilent p/n G2530-60029
Hybridization Chambers
Ozone-barrier slide covers (box of 20)* Agilent p/n G2505-60550
PlateLoc Thermal Microplate Sealer and Agilent p/n G5402A and
Peelable Aluminum Seal PP/PS Agilent p/n 24210-001
or
Manual Heat Sealer Eppendorf p/n 951023078 and
Peel-it-lite Foil (removable) Eppendorf p/n 951023205
UV-Transilluminator with SYBR photographic filter Alpha Innotech p/n Alphalmager

2000 or equivalent

Nuclease-free 1.5 mL microfuge tubes (sustainable at 95°C) Ambion p/n AM12400 or equivalent
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Before You Begin

Table7  Required equipment (continued)

Description

Company and part no.

Magnetic stir bar (x2 or ><4)Jr

Magnetic stir plate (x1 or x3)

Magnetic stir plate with heating element
Microcentrifuge

Thermocycler with heated lid

Full skirted 96-well plate PCR plates compatible with Bravo
platform and thermocycler

Centrifuge (for 96-well plate)
384-Well Deep Well Microplates
E-Gel Opener1

E-Gel PowerBase v.4*

Qubit Fluorometer

UV-VIS spectrophotometer
P10, P20, P200 and P1000 pipettes

1.5 L glass dish

Deep reservoir, 12 column partitions, V bottom, natural
polypropylene

250 mL capacity slide-staining dish, with slide rack
(%3 or xb)t

Circulating water baths or heat blocks set to 56°and 90°C
(for DNA extraction)

Ice bucket

Clean forceps

Powder-free gloves

Sterile, nuclease-free aerosol barrier pipette tips

Timer

Corning p/n 401435 or equivalent
Corning p/n 6795-410 or equivalent
Corning p/n 6795-420 or equivalent
Eppendorf p/n 5430 or equivalent

Eppendorf p/n 950000015 or
equivalent

Eppendorf p/n 951020401

Eppendorf p/n 5810 or equivalent
Greiner Bio-One p/n 781270
Invitrogen p/n G5300-01
Invitrogen p/n G6200-04
Invitrogen p/n Q32857

NanoDrop 8000 or 2000, or
equivalent

Pipetman P10, P20, P200, P1000 or
equivalent

Pyrex p/n 213-R or equivalent
V&P Scientific p/n VP 572DC

Wheaton p/n 900200 or
Thermo Shandon p/n 121
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Before You Begin 1
Table7  Required equipment (continued)
Description Company and part no.
Vacuum dessicator or N purge box for slide storage
Vortex mixer
* Optional when processing arrays in environments in which ozone levels are 5 ppb or higher.
t The number varies depending on if wash procedure A or B is selected.
1 Optional when Invitrogen E-gels are used.
** Optional.
Table 8  Required equipment for hybridization preparation for 1x microarrays.
Description Company and part no.
Deep-well plates ABgene p/n AB-0859
Eppendorf ThermoStat Eppendorf p/n 022670204
Eppendorf Deep-Well Plate Block Eppendorf p/n 022670565
Table9  Required equipment for hybridization preparation for 2x microarrays.
Description Company and part no.
Tall Chimney PCR plates ABgene p/n AB-1184
Table 10  Required equipment for 4x and 8x microarrays.
Description Company and part no.
Vacuum Concentrator Thermo Scientific p/n DNA120-115 or
equivalent
Table 11 Optional equipment for DNA extraction from tissue or FFPE samples.
Description Company and part no.
Thermal shaker Eppendorf Thermomixer p/n 022670000 or equivalent
Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform 19
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Required Reagents

Table 12 Required reagents for gDNA isolation

Description Company and part no.

Phosphate Buffered Saline pH 7.4 (PBS) Amresco p/n E504-500ML

Clear E-Gel 18-Pak (1.2% agarose, no stain) Invitrogen p/n G5518-01
SYBR Gold Nucleic Acid Gel Stain Invitrogen p/n S11494
Tracklt 1 Kb DNA Ladder Invitrogen p/n 10488-072

Quant-IT dsDNA BR Assay Kit, for use with Invitrogen p/n 032850
the Qubit fluorometer (100 assays)

Qiagen RNase A (100 mg/mL) Qiagen p/n 19101

Qiagen DNeasy Blood & Tissue Kit Qiagen p/n 69504

Qiagen Proteinase K (>600 mAU/mL, Qiagen p/n 19131
solution)

Sodium thiocyanate (NaSCN)" Sigma 467871-50G

Ethanol (95% to 100% molecular biology Sigma p/n E7023-6x500ML
grade)

Tween 20 Sigma p/n P9416-50ML

* Optional.

t Optional components if isolating DNA from FFPE samples.

Table 13  Required reagents for enzymatic sample prep and labeling

Description Company and part no.
Agilent Genomic DNA Enzymatic Labeling Kit ~ Agilent p/n 5190-0449
AutoScreen-96A Well plates GE Healthcare p/n 25-9005-98
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Table 13  Required reagents for enzymatic sample prep and labeling (continued)
Description (continued) Company and part no.
For possible use as a reference sample:
Human Genomic DNA or For CGH microarrays: Promega p/n G1521
(female) or p/n G1471 (male)
For CGH+SNP microarrays: Coriell p/n NA18507,
NA18517, NA12891, NA12878, or p/n NA18579
Mouse Genomic DNA or Jackson Labs p/n 000664 (female and male)
Rat Genomic DNA Harlan Sprague Dawley (custom)
Alul (10 U/uL)* Promega p/n R6281
Rsal (10 U/uL)* Promega p/n R6371
1 x TE (pH 8.0), Molecular grade Promega p/n V6231
GenElute PCR Clean-Up Kit" Sigma p/n NA1020
GenomePlex Complete Whole Genome Sigma p/n WGA2
Amplification Kit'
* Optional component recommended if doing a restriction digestion step when you process CGH
microarrays. Required when you process SurePrint G3 CGH+SNP microarrays.
t Optional components recommended if using the Amplification Method for sample preparation.
Table 14 Required reagents for ULS sample prep and Iabeling*
Description Company and part no.
Genomic DNA High-Throughput ULS Labeling  Agilent p/n 5190-0450
Kit
Genomic DNA 96-well Purification Module Agilent p/n 5190-0451
For possible use as a reference sample:
Human Genomic DNA or Promega p/n G1521 (female) or p/n G1471 (male)
Mouse Genomic DNA or Jackson Labs p/n 000664 (female and male)
Rat Genomic DNA Harlan Sprague Dawley (custom)
* ULS is not supported for CGH+SNP.
Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform 21
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Table 15 Required reagents for hybridization and wash

Description Company and part no.
Agilent Oligo aCGH Wash Buffer 1 and 2 set  Agilent p/n 5188-5226
or
Agilent Oligo aCGH Wash Buffer 1 (4 L) Agilent p/n 5188-5221
Agilent Oligo aCGH Wash Buffer 2 (4 L) Agilent p/n 5188-5222
Stabilization and Drying Solution, 500 mL’ Agilent p/n 5185-5979
Agilent Oligo aCGH Hybridization Kit Agilent p/n 5188-5220 (25) or p/n 5188-5380 (100)
Human Cot-1 DNA or Invitrogen p/n 15279-011 or 15279-101 or
Kreatech p/n EA-020
Mouse Cot-1 DNA or Invitrogen p/n 18440-016
Rat Hybloc Applied Genetics p/n RHB
Acetonitrile” Sigma p/n 271004-1L

*

Optional components recommended if wash procedure B is selected.

Required Bravo Platform Protocols

¢ The Agilent Oligo aCGH Bravo Platform protocols are on the CD that came
with your Bravo platform or may be obtained by contacting your local
Agilent product specialist.

Required Hardware and Software

¢ Refer to the Bravo Platform User Guide and the VWorks Automation
Control User Guide for minimum and recommended computer
requirements. See http://www.genomics.agilent.com.

¢ Refer to the Agilent Scanner and Feature Extraction manuals for minimum
memory requirements and other specifications. Go to
http://www.genomics.agilent.com.
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Agilent cannot guarantee microarray performance and does not provide technical support
to those who use non-Agilent protocols in processing Agilent microarrays.

Agilent’s array-based Comparative Genomic Hybridization (aCGH) application
uses a “two-color” process to measure DNA copy number changes in an
experimental sample relative to a reference sample. The type of sample used
as a reference is a matter of experimental choice; however, many
experimenters use normal commercial gDNA as a reference sample.

This chapter describes Agilent’s recommended procedure to isolate genomic
DNA (gDNA) from blood, cells, frozen or FFPE tissues using the Qiagen
DNeasy Blood & Tissue Kit (p/n 69504). Minor differences exist in the DNA
extraction procedure between the ULS and Enzymatic processing method that
you will choose in Chapter 4.

FFPE samples are not supported when you process SurePrint G3 CGH+SNP
microarrays. For DNA isolated from FFPE tissues, ULS processing is the only
option. Follow the instructions in “FFPE Tissues” on page 32.
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CGH+SNP Microarrays

When you process SurePrint G3 CGH+SNP microarrays, the reference needs to
be DNA isolated from a single genotyped individual. You can use one of the
following supported HapMap samples: NA18507 (Yoruban Male), NA18517
(Yoruban Female), NA12891 (European Male), NA12878 (European Female),
or NA18579 (Chinese Female). The HapMap samples can be ordered from the
Coriell Institute for Medical Research. Or you can genotype your own
reference isolated from a single individual by hybridizing it against all 5
supported HapMap samples on the Agilent CGH+SNP microarrays. This
experiment only needs to be done once.

The input amount of DNA for the experimental labeling reaction must be the
same as for the reference sample labeling reaction. Inaccurate DNA
quantitation can lead to different DNA inputs into the experimental and
reference labeling reactions, which increases assay noise (DLRSD). Different
DNA isolation methods can create different quantitation artifacts, so a higher
risk of assay noise exists when the experimental and reference DNA samples
are isolated from different sources (for example, experimental DNA isolated
from blood and reference DNA obtained from a Coriell cell line).

To minimize assay noise, especially when experimental and reference samples
are isolated from different sources, measure the DNA concentration with both
a spectrophotometer (e.g. Nanodrop) and a fluorometer (e.g. Qubit) to give you
two independent methods of measurement.
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Oligo aCGH Workflow

“DNA Isolation” on page 23 . . .
Experimental gDNA isolation

from blood, cells, frozen tissue
or FFPE tissue

“Sample Preparation for
Bravo Platform” on page 37

{ Fragmentation of gDNA ]

{ Labeling of gDNA j

[ Clean-up of labeled gDNA ]

Reference gDNA from
commercial source or isolation
from blood, cells, frozen tissue

or FFPE tissue

[ Fragmentation of gDNA ]

[ Labeling of gDNA j

( Clean-up of labeled gDNA ]
|

v

‘ Preparation before ‘
hybridization

“Microarray Processing and

Feature Extraction” on page 95 ‘

24- or 40-hour hybridization

(65°C) ‘

v

[ Microarray washing j

v

[ Microarray scanning j

v

[ Feature extraction j

Figure 1

Workflow diagram for sample preparation and microarray processing. Steps

that are in blue use the Bravo Automated Liquid Handling Platform.
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Blood, Cells or Frozen Tissues

This section describes Agilent’s recommended procedure to isolate genomic
DNA (gDNA) from blood, cells or frozen tissues using the Qiagen DNeasy Blood
& Tissue Kit (p/n 69504).

Table 16  Required gDNA amount from blood, cells or frozen tissues

Microarray format  ULS gDNA input amount Enzymatic gDNA input amount Enzymatic gDNA input amount

requirement (ng) requirement (ng)*for CGH requirement (ng) for CGH+SNP’
1x microarray 1500 500 1000
2x microarray 1000 500 1000
4x microarray 500 500 1000
8x microarray 250 200 500

* You can use more gDNA, but the gDNA needs to be at a higher concentration. See Table 18, Table 19 and Table 20 on
page 39 for required concentrations.

Step 1. gDNA Extraction

1 Equilibrate a thermomixer to 55°C and heat block or water bath to 56°C.
2 For blood with nonnucleated erythrocytes (mammals):

a Put 20 puL proteinase K (supplied with Qiagen DNeasy Blood & Tissue
Kit) into the bottom of a 1.5 mL microfuge tube.

b Add 50 to 100 uL anticoagulated blood.
¢ Add enough PBS to make a total volume of 220 uL.
d Go to step 7.
3 For blood with nucleated erythrocytes (such as chicken):

a Put 20 uL proteinase K (supplied with Qiagen DNeasy Blood & Tissue
Kit) into the bottom of a 1.5 mL microfuge tube.

b Add 5 to 10 uL anticoagulated blood.
¢ Add enough PBS to make a total volume of 220 uL.
d Gotostep 7.
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4 For cells:

a Spin a maximum of 5x10° cells in a centrifuge for 5 minutes at 300 x g.
Resuspend the pellet in 200 uL. PBS.

b Add 20 uL proteinase K (supplied with Qiagen DNeasy Blood & Tissue
Kit).

¢ Gotostep 7.
5 For frozen tissue:

a Cut up to 25 mg frozen tissue (up to 10 mg for spleen tissue) into small
pieces and put into a 1.5 mL microfuge tube.

b Add 180 uL Buffer ATL (supplied with Qiagen DNeasy Blood & Tissue
Kit).

¢ Add 20 pL proteinase K (supplied).
d Mix well on a vortex mixer.

e Incubate in a thermomixer at 55°C shaking at 450 rpm until the tissue is
completely lysed.

Lysis time varies depending on the type of tissue processed. Usually lysis
is complete in 1 to 3 hours. If it is more convenient, samples can be lysed
overnight.

f Let the sample cool to room temperature and spin in a microcentrifuge
for 30 seconds at 6,000 x g to drive the contents off the walls and lid.

g Go to step 7.
6 For further purification of extracted DNA:
a Take a maximum 25 ug of DNA.
b Add enough PBS to make a total volume of 220 uL.

¢ Add 20 pL proteinase K (supplied with Qiagen DNeasy Blood & Tissue
Kit).

7 Add 4 uL RNase A (100 mg/mL), mix on a vortex mixer, and incubate for 2
minutes at room temperature. Spin in a microcentrifuge for 30 seconds at
6,000 x g to drive the contents off the walls and lid.

8 Add 200 uL Buffer AL (supplied) to each sample, mix thoroughly on a
vortex mixer, and incubate at 56°C for 10 minutes in a heat block or water
bath. Spin in a microcentrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.
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9 Add 200 uL 100% ethanol to each sample, and mix thoroughly on a vortex
mixer. Spin in a microcentrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

10 Transfer the sample mixture onto a DNeasy Mini spin column in a 2 mL
collection tube (supplied). Spin in a centrifuge at 6,000 x g for 1 minute.
Discard the flow-through and collection tube. Put the DNeasy Mini spin
column in a new 2 mL collection tube (supplied).

11 Before using for the first time, prepare Buffer AW1 by adding 100% ethanol
to the Buffer AW1 bottle (supplied; see bottle label for volume). Mark the
appropriate check box to indicate that ethanol was added to the bottle.

12 Add 500 uL Buffer AW1 onto the column, and spin in a microcentrifuge for
1 minute at 6,000 x g. Discard the flow-through and collection tube. Put the
DNeasy Mini spin column in a new 2 mL collection tube (supplied).

13 For Enzymatic labeling: Before using for the first time, prepare Buffer AW2
by adding 100% ethanol to the Buffer AW2 bottle (supplied; see bottle label
for volume). Mark the appropriate check box to indicate that ethanol was
added to the bottle.

14 For ULS labeling: Prepare a fresh 80% ethanol solution by adding 40 mL
100% ethanol to 10 mL nuclease-free water.

For ULS labeling: Do not use Buffer AW2 supplied with the Qiagen DNeasy Blood &
Tissue Kit for the subsequent step because salt from Buffer AW2 will interfere with the
subsequent labeling reaction. This is especially important if you need to do a
concentration step before labeling.

15 Add the amount below onto the column, and spin in a centrifuge for 3
minutes at 20,000 x g to dry the DNeasy membrane. Discard the
flow-through and collection tube.

For ULS labeling: 500 uL 80% ethanol
For Enzymatic labeling: 500 uL Buffer AW2

16 Put the DNeasy Mini spin column in a clean 1.5 mL microcentrifuge tube,
and pipette the amount below directly onto the center of the DNeasy
column membrane.

For ULS labeling: 200 uL of nuclease free water
For Enzymatic labeling: 200 uL of Buffer AE (supplied)

17 Incubate at room temperature for 1 minute, and then spin in a
microcentrifuge for 1 minute at 6,000 x g to elute the DNA.
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18 Repeat elution with nuclease-free water (for ULS labeling) or Buffer AE (for
Enzymatic labeling) once as described in step 16 and step 17. Combine the
duplicate samples in one microcentrifuge tube for a final volume of 400 uL.

For ULS labeling: If long term storage is needed, store DNA that was eluted in water at
-20°C. Make small aliquots before you freeze the DNA so as to avoid repeated freeze-thaw
cycles.
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Step 2. gDNA Quantitation and Quality Analysis

Accurate assessment of gDNA quantity and quality are crucial to the success
of an Agilent Oligo aCGH experiment. High quality gDNA should be free of
contaminants such as carbohydrates, proteins, and traces of organic solvents,
and should also be intact with minimal degradation. gDNA isolated from FFPE
samples typically exhibits varying degrees of degradation depending on the
age of the tissue and the paraffin embedding protocol used. See “FFPE
Tissues” on page 32 for details on how to isolate gDNA from FFPE tissues.

FFPE samples are not supported when you process SurePrint G3 CGH+SNP
microarrays.

Use the NanoDrop 2000 UV-VIS Spectrophotometer (or equivalent) to assess
gDNA concentration and purity. Use agarose gel electrophoresis to assess
gDNA intactness and the average molecular weight for each sample.

UV-VIS Spectrophotometry

1 In the Nanodrop program menu, select Nucleic Acid Measurement, then
select Sample Type to be DNA-50.

2 Use 1.5 uL of nuclease-free water (for ULS labeling) or elution buffer (for
Enzymatic labeling) to blank the instrument.

3 Use 1.5 uL of each gDNA sample to measure DNA concentration. Record the
gDNA concentration (ng/uL) for each sample. Calculate the yield as

DNA Concentration (ng/uL) - Sample Volume (uL)
1000 ng/pg

4 Record the Agg/Asgy and Agg/Asgg ratios. High-quality gDNA samples
have an Aggg/Agg ratio of 1.8 to 2.0, which indicates the absence of
contaminating proteins. Scanning the absorbance from 220-320 nm will
show whether contaminants exist that affect absorbance at 260 nm. Check
the absorbance scans for a peak at 260 nm and an overall smooth shape as
shown in Figure 2. The ideal 260/230 ratio for pure DNA is >1.0.

Yield (ug) =
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Figure 2 Typical spectrum of pure DNA

Agarose Gel Electrophoresis

1 Load 20 ng gDNA for each sample in a volume of 10 uL nuclease-free water
in the well of a single-comb 1.2% Clear E-Gel. (You do not need to add
loading buffer in this system).

2 As a control, load 20 ng of commercial Human Genomic DNA in a volume of
10 uL nuclease free water in one of the wells of the E-Gel.

3 Mix 5 uL TrackIt 1 Kb DNA Ladder with 95 uL deionized water and load 10
uL of the diluted ladder in one of the wells of the E-Gel.

4 Run the gel for 30 minutes as described in Invitrogen's instructions.

5 Open the gel cassette with E-Gel Opener as described in Invitrogen’s
instructions.

6 Stain the gel with SYBR Gold Nucleic Acid Gel Stain (diluted 1:10,000 by
adding 10 pL of SYBR Gold Nucleic Acid Gel Stain to 100 mL of
nuclease-free water) in a plastic tray for 15 minutes.

7 Visualize the gel on the UV-transilluminator using a SYBR Gold
photographic filter.
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32

This section describes Agilent’s recommended procedure to isolate genomic
DNA (gDNA) from formalin-fixed paraffin-embedded (FFPE) samples and is
based on the method described by van Beers et al. (Br J Cancer. 2006 Jan 30;
94(2):333-7) using the Qiagen DNeasy Blood & Tissue Kit (p/n 69504).
Determine the number of FFPE sections needed for your experiment based on
the estimates summarized in Table 17. One 20 micron FFPE section containing
1 em? of tissue is estimated to generate a minimal yield of 500 ng of gDNA.

For more information about CGH experiments on FFPE samples, please refer
to the application note “Copy Number Analysis of Archival FFPE Tumor
Samples by Oligo Array CGH” (p/n 5989-7120EN) available from the Agilent
Web site at www.agilent.com/chem/dnaapplications. Note that the CGH+SNP
platform does not support FFPE samples.

Table 17  Estimated number of 20 micron FFPE sections needed per microarray

Microarray format gDNA input amount Estimated number of 20
requirement (ng) micron FFPE sections

1x microarray 2000 4105

2x microarray 1000 3

4x microarray 500 2

8x microarray 250 1

Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform
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Step 1. Paraffin Removal

1 Equilibrate a heat block or water bath to 90°C and a thermomixer to 37°C.

2 Put up to 5 20-micron FFPE sections into a 1.5 mL nuclease-free microfuge
tube.

3 Prepare 10% Tween 20, by adding 100 uL. Tween 20 to 900 uL of
nuclease-free water. The solution can be prepared in advance and stored up
to 6 months at room temperature.

4 Add 480 uL PBS and 20 uL 10% Tween 20 to the FFPE sections in the 1.5
mL nuclease-free microfuge tube.

5 Transfer the sample tube to a circulating water bath or heat block at 90°C.
Incubate at 90°C for 10 minutes.

6 Spin immediately for 15 minutes at 10,000 x g in a microcentrifuge.
7 Put the sample tube on ice for 2 minutes.

8 Remove the resulting wax disc with a pipette tip or tweezers. Remove and
discard the supernatant without disturbing the pellet.

9 Add 1 mL of 100% ethanol to the pellet and vortex briefly.
10 Spin for 5 minutes at 10,000 x g in a microcentrifuge.

11 Remove ethanol without disturbing the pellet and let the sample tube sit at
room temperature with the lid open until residual ethanol has completely
evaporated.

12 Prepare a 1M NaSCN solution by adding 10 g of NaSCN to 123 mL of
nuclease free water. The solution can be prepared in advance and stored up
to 1 month at room temperature.

13 Add 400 uL 1M NaSCN to the dry pellet and briefly mix on a vortex mixer.

14 Transfer the sample tube to a thermomixer at 37°C. Incubate overnight at
37°C. Shake at 450 rpm.
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Step 2. Proteinase K Treatment

N

N o o AW

Equilibrate a thermomixer to 565°C.

Transfer the sample tube to a microcentrifuge. Spin for 20 minutes at
10,000 x g.

Remove and discard the supernatant without disturbing the pellet.
Add 400 uL PBS to the pellet and vortex briefly.

Spin again for 20 minutes at 10,000 x g in a microcentrifuge.
Remove and discard the supernatant without disturbing the pellet.

Add 360 uL of Qiagen buffer ATL (supplied with Qiagen DNeasy Blood &
Tissue Kit).

Add 40 uL proteinase K (supplied), mix well on a vortex mixer, and
incubate overnight in a thermomixer at 55°C shaking at 450 rpm.

Transfer the sample tube to a microcentrifuge. Spin for 30 seconds at 6,000
x g to drive the contents off the walls and lid.

10 Add 40 uL proteinase K, mix well on a vortex mixer, and incubate in a

thermomixer for approximately 6 to 8 hours at 55°C shaking at 450 rpm.

11 At the end of the day, transfer the sample tube to a microcentrifuge and

spin for 30 seconds at 6,000 x g to drive the contents off the walls and lid.

12 Add 40 pL proteinase K, mix well on a vortex mixer and incubate overnight

in a thermomixer at 55°C shaking at 450 rpm.
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Step 3. gDNA Extraction

1 Equilibrate a heat block or water bath to 56°C.

2 Let samples cool to room temperature and spin in a microcentrifuge for 30
seconds at 6,000 x g to drive the contents off the walls and lid.

3 Add 8 uL of RNase A (100 mg/mL), mix on a vortex mixer, and incubate for
2 minutes at room temperature. Transfer the sample tube to a
microcentrifuge and spin for 30 seconds at 6,000 x g to drive the contents
off the walls and lid.

4 Add 400 uL Buffer AL (supplied), mix thoroughly on a vortex mixer, and
incubate in a circulating water bath or heat block at 56°C for 10 minutes.
Transfer the sample tube to a microcentrifuge and spin for 30 seconds at
6,000 x g to drive the contents off the walls and lid.

5 Add 440 uL 100% ethanol, and mix thoroughly on a vortex mixer. Transfer
the sample tube to a microcentrifuge and spin for 30 seconds at 6,000 x g to
drive the contents off the walls and lid.

6 Put two DNeasy Mini spin columns in two clean 2 mL collection tubes
(supplied). Split the entire sample mixture onto two DNeasy Mini spin
columns (i.e. 660 uL each).

Use two DNeasy Mini spin columns per sample to prevent clogging.

7 Spin in a microcentrifuge for 1 minute at 6,000 x g. Discard the
flow-through and collection tube. Put the DNeasy Mini spin columns in
fresh 2 mL collection tubes (supplied).

8 Before using for the first time, prepare Buffer AW1 by adding 100% ethanol
to the Buffer AW1 bottle (supplied; see bottle label for volume). Mark the
appropriate check box to indicate that ethanol was added to the bottle.

9 Add 500 uL Buffer AW1 onto each spin column, and spin in a centrifuge for
1 minute at 6,000 x g. Discard the flow-through and collection tube. Put the
DNeasy Mini spin columns in fresh 2 mL collection tubes (supplied).
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10 Prepare a fresh 80% ethanol solution by adding 40 mL 100% ethanol to 10
mL nuclease-free water.

Do not use Buffer AW2 supplied with the Qiagen DNeasy Blood & Tissue Kit for the
subsequent step because salt from Buffer AW2 will interfere with the subsequent
labeling reaction. This is especially important if you need to do a concentration step
before labeling.

11 Add 500 uL 80% ethanol onto each column, and spin in a microcentrifuge
for 3 minutes at 20,000 x g to dry the column membrane. Discard the
flow-through and collection tube.

12 Put the DNeasy Mini spin column in a clean 1.5 mL microcentrifuge tube,
and add 50 uL of nuclease free water directly to the center of each spin
column.

13 Let stand at room temperature for 1 minute, and then spin in a
microcentrifuge for 1 minute at 6,000 x g to elute the DNA.

14 Combine the purified DNA from the same sample in one microcentrifuge
tube for a final total volume of 100 uL.

Measure gDNA concentration and purity, and analyze on an agarose gel as
described in “Step 2. gDNA Quantitation and Quality Analysis” on page 30.

If long term storage is needed, store DNA that was eluted in water at -20°C. Make small
aliquots before you freeze the DNA so as to avoid repeated freeze-thaw cycles.
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This chapter describes how to prepare the samples to be used on the
Bravo Automated Liquid Handling Platform.

Use equal amounts of gDNA for both the experimental and reference channels. The
required gDNA input amount and concentration depends on the microarray format,
labeling method and DNA source used (see Table 16 and Table 17).

Follow the DNA isolation procedure described in Chapter 2, “DNA Isolation”. Failure to
clean samples thoroughly will result in unsatisfactory microarray results.

If the DNA isolation procedure described in this document cannot be followed, make
sure that the DNA is free of RNA and protein contamination. For ULS labeling, also
make sure the DNA is in one of the following buffers compatible with ULS labeling:

+ TE-buffer (10 mM Tris-HCI, 1 mM EDTA, pH 7.5 or pH 8)
+ 10 mMLiCl

* 10to 100 mM Na acetate

* 10 mM NaCl

If needed, repurify already isolated DNA. Start from step 6 on page 27 in the previous
chapter.

Make sure that the gDNA is completely in solution by pipetting up and down. If needed,
incubate at 37°C for 30 minutes. If the gDNA concentration is > 350 ng/pL, dilute 1:2 in
water and requantitate to make sure quantitation is accurate.
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Step 1. gDNA Dilution

¢ Dilute the gDNA with nuclease-free water to the concentration listed in
Table 18, Table 19, and Table 20.

Make sure that the volume is higher than the minimum volume
requirement for the Bravo platform (uL).

If the gDNA concentration is less than those listed in Table 18, Table 19, and
Table 20, concentrate the sample using a concentrator (such as Speed Vac) to
dryness and resuspend in water to the final concentration listed above.

Do not excessively dry the gDNA as the pellets will become difficult to resuspend.

Table 18 gDNA concentration and input amount required per microarray for ULS labeling

Microarray format Concentration Minimum volume  Volume that Bravo
requirement requirement for platform will use
(ng/pL) Bravo platform

(pL)

1x microarray (non-FFPE 100 17 15

samples)

1x microarray (FFPE samples) 133.5 17 15

2x microarray 100 12 10

4x microarray 100 7 5

8x microarray 50 7 5

*

If you want to use more gDNA than what is listed in Table 16 on page 26, use gDNA that is at a high-
er concentration than is listed in this table.
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Table 19 For CGH: gDNA concentration and input amount required per microarray for
Enzymatic labeling

Microarray format Concentration Minimum volume  Volume that Bravo
requirement requirement for platform will use
(ng/pL) Bravo platform
(nL)
1x, 2x and 4x microarray 100 7 5
8x microarray 50 6 4

*

If you want to use more gDNA than what is listed in Table 16 on page 26, use gDNA that s at a high-
er concentration than is listed in this table.

Table 20 For CGH+SNP: gDNA concentration and input amount required per microarray
for Enzymatic labeling

Microarray format Concentration Minimum volume  Volume that Bravo
requirement requirement for platform will use
(ng/pL) Bravo platform
(nL)
1x, 2x and 4x microarray 50 22 20
8x microarray 4 9 7

*

If you want to use more gDNA than what is listed in Table 16 on page 26, use gDNA that s at a high-
er concentration than is listed in this table.
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Step 2. gDNA Placement in a 96-Well Plate

1 In a full skirted 96-well plate (Eppendorf p/n 951020401), put the
experimental gDNA samples in columns 1 through 6 of the 96-well plate
as indicated in Figure 3.

2 Put the reference gDNA in columns 7 through 12 as indicated in Figure 3.

Make sure that the experimental and reference gDNA samples meet the
minimum volume requirements indicated in Table 18 on page 38, or
Table 19 or Table 20 on page 39.

3 Make sure that no air bubbles are stuck at the bottom of the well. If
needed, spin the plate in a centrifuge for 30 seconds at 6,000 x g to
drive the contents off the walls.

Figure 3 96-well layout of gDNA before labeling. Columns 1 through 6 contain 48 exper-
imental gDNA samples (blue). Columns 7 through 12 contain 48 reference
gDNA samples (pink).

You can process between 1 and 48 experimental samples, but to minimize
reagent waste, choose 8, 16, 24, 32, 40 or 48 samples. If you process fewer
than 48 samples, add gDNA to the wells column-wise. Fill columns 1 and
7 before you continue to columns 2 and 8.

The Agilent Oligo aCGH Bravo platform protocols are based on the plate configuration
in Figure 3. Therefore, the first 6 columns are always experimental samples and the last
6 columns are always references. The reference sample for Al is in A7, the reference
sample for B1is in B7, and so on. The pattern for reference DNAs must match the
sample pattern. If this configuration is not followed, the samples will not process
correctly.
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Step 1. Enzymatic Labeling 62
Step 2. Purification after Enzymatic labeling 67
To determine yield, degree of labeling or specific activity 69
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Step 3. Preparation of Enzymatic Labeled Genomic DNA for
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This chapter describes the fragmentation, labeling, clean-up and preparation
of labeled gDNA for hybridization done on the Bravo platform.

The Agilent Oligo aCGH Bravo Platform protocols are on the CD that came
with your Bravo platform or may be obtained by contacting your local Agilent
product specialist. Nine protocols are available, three each for ULS processing,
Enzymatic processing for CGH, and Enzymatic processing for CGH+SNP.
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For ULS processing

¢ FragmentationLabelingProtocol_ULS (contains both the Fragmentation
and Labeling protocol)

¢ PurificationProtocol _ULS

e HybridizationPrepProtocol_ULS

For Enzymatic CGH processing

¢ FragmentationLabelingProtocol_Enz (contains both the Fragmentation and
Labeling protocol)

¢ PurificationProtocol_Enz

¢ HybridizationPrepProtocol_Enz

For Enzymatic CGH+SNP processing

¢ CGH+SNP_RestrictionDigestionLabelingProtocol_Enz (contains both the
Restriction Digestion and Labeling protocol)

¢ CGH+SNP_PurificationProtocol_Enz
¢ CGH+SNP_HybridizationPrepProtocol_Enz

For DNA isolated from blood, cells or frozen tissue choose either ULS or
Enzymatic processing methods. For DNA isolated from FFPE tissues choose
the ULS processing method.

ULS Labeling

The Genomic DNA High-Throughput ULS Labeling Kit (p/n 56190-0450) uses a
non-enzymatic procedure to differentially label gDNA samples with
fluorescent dyes. The kit contains two-color labeling reaction reagents
sufficient for:

¢ 16 1x arrays (blood, cells, tissue samples)
¢ 12 1x arrays (FFPE samples) or

e 24 2x arrays or

e 48 4x arrays or

¢ 96 8x arrays

You also need to order the Genomic DNA 96-well Purification Module (p/n
5190-0451) to purify the labeled DNA.
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Enzymatic Labeling for CGH or CGH+SNP

If you choose the Enzymatic processing method for the CGH or CGH+SNP
microarrays, you will need 2 Bravo Platform CPAC Ultraflat heated/cooled
Deck Pads and the Riser option on the Bravo platform (Agilent p/n G5409A
Option 002).

The processing of CGH+SNP microarrays requires the restriction digestion of
the gDNA with Alul and Rsal prior to labeling, to enable the genotyping of
SNPs located in the enzymes' recognition sites for the detection of LOH/UPD.

The Agilent Genomic DNA Enzymatic Labeling Kit (Agilent p/n 5190-0449)
uses random primers and the exo-Klenow fragment to differentially label
genomic DNA samples with fluorescent-labeled nucleotides. The kit contains
sufficient two-color labeling reaction agents for:

e 25 1x, 2x and 4x arrays or

¢ 50 8x arrays

You also need to order the AutoScreen-96A Well plates (GE Healthcare p/n
25-9005-98) to purify the labeled DNA.

For Agilent's Oligo aCGH application (including CGH+SNP microarrays), the
experimental sample is labeled with one dye (Cy5), while the reference sample
is labeled with the other dye (Cy3). The Agilent Oligo aCGH protocols available
for the Bravo platform will label the experimental samples and reference
samples with their respective dye.

About the Bravo Platform

The Bravo platform is a versatile liquid handler with a nine plate-location
platform deck, suitable for handling 96-well, 384-well, and 1536-well plates.
The Bravo platform is controlled by the VWorks Automation Control software.
Fitted with a choice of seven interchangeable fixed-tip or disposable-tip
pipette heads, it accurately dispenses fluids from 0.1 uL to 250 uL.

Use Figure 4 to familiarize yourself with the location numbering convention
on the Bravo platform deck.
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Back

Front

Figure 4 Bravo platform deck

Before you begin, make sure that you have read and understand operating,
maintenance and safety instructions for using your Bravo platform. Refer to the Bravo
Platform User Guide (G5409-90004) and the VWWorks Software User Guide
(G5415-90002).
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Setting up the VWorks Software

To communicate with and to control the robot and integrated devices, the
VWorks software uses a device file. You need to create a device file and link
the protocols to that device file. See the VWorks User Guide for instructions.

Step 1. Log in to the VWorks software

1 Double-click the VWorks icon on the Windows desktop to start the software.

2 In the VWorks window, click Log in on the toolbar. The User Authentication
dialog box opens.

3 Type your VWorks user name and password, and click OK. (If no user
account is set up, contact the administrator.)

Step 2. Open and start a protocol

1 Click File > Open. The Open dialog box opens.

2 Locate and select the protocol (.pro) file that you want to open, and click
Open.

3 Click Simulation is on in the VWorks toolbar to turn off the simulation
mode.

The button changes to “Simulation is off”.
4 Click Start on the toolbar.

The Run Configuration Wizard dialog box opens.
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5 For each prompt, respond as follows. Click Next between each response:

Run protocol this many times 1
Determine when the protocol will start  As soon as possible

Current state of the tip boxes Select tip box location and click the
icon on the right. Make sure that the
state of the tip boxes matches that
in the prompt. For example, tip box
at location 1 is empty and tip box at
location 2 appears full in the
prompt.

Add notes about the protocol Optional.

Click Finish.
The Confirm Labware Placement dialog box opens.

Confirm that the labware on the Bravo platform deck matches the diagram
in the software and click Continue.

The working plate location appears empty in the VWorks program.

In the Array format dialog box, type the number that corresponds to the
microarray format, then click Continue.

1x1IM or 1x244K microarrays
2x400K or 2x105K microarrays
4x180K or 4x44K microarrays

o N

8x60K or 8x15K microarrays

The Select columns dialog box opens.

Type the number of experimental samples you will process in the run. Do
not count the number of reference samples.

You can process between 1 and 48 samples. To optimize reagent use, select
8, 16, 24, 32, 40 or 48 samples.
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ULS Labeling

Follow these steps if you are using ULS Labeling. Otherwise, continue to
“Enzymatic Labeling for CGH” on page 62 or “Enzymatic Labeling for
CGH+SNP” on page 76.

Step 1. ULS Labeling

In this step, the Bravo platform transfers the correct amount of gDNA from the
96-well plate that was prepared in Chapter 3, “Sample Preparation for Bravo
Platform”, to the working plate. You fragment the gDNA in a thermocycler, the
Bravo platform adds the Labeling Master Mix to the fragmented gDNA, then
the reactions occur in a thermocycler.

Do not fragment gDNA isolated from FFPE tissues.

Bravo Platform  FragmentationLabelingProtocol_ULS

Protocol
Initial Deck
Layout Location Content
1and7 Empty tip box
2and 8 Full tip box
6 384 deep well plate:

» Cyb Labeling Master Mix in quadrant 1
» Cy3 Labeling Master Mix in quadrant 3

4 Empty working plate (Eppendorf p/n 951020401)

5 Sample plate containing the gDNA (prepared in Chapter 3)
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Step 1. ULS Labeling

1 Based on your microarray format and sample type, prepare one Cy3 and
one Cyb Labeling Master Mix by mixing the respective components in
Table 21 through Table 25.

Table 21  Multiplier to calculate the volume of Labeling Master Mix (for 1x microarrays
using non-FFPE samples)*

Components Per reaction  Total volume needed Volume to add per well of
(pL) 384 deep well plate

Nuclease-free water 15 (1.5puLx N) + 9.6 pL

ULS-Cy3 or ULS-Cy5 15 (1.5 L x N) +9.6 L

10 x labeling solution 2 (2pLx N) +12.8 pL

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.

Table 22  Multiplier to calculate the volume of Labeling Master Mix (for 1x microarrays
using FFPE samples)*

Components Per reaction  Total volume needed Volume to add per well of
(nL) 384 deep well plate

Nuclease-free water 1 (TpuLx N) +6.4 pL

ULS-Cy3 or ULS-Cyb 2 (2pLx N)+12.8 pL

10 x labeling solution 2 (2pLx N) +12.8 L

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.
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Step 1. ULS Labeling

Table 23 Multiplier to calculate the volume of Labeling Master Mix (for 2x microarrays
using non-FFPE and FFPE samples)*

Components Per reaction Total volume needed Volume to add per well of
(L) 384 deep well plate

Nuclease-free water 7 (7uLx N) +22.4 pL

ULS-Cy3 or ULS-Cyb 1 (1 puLx N) +3.2 pL

10 x labeling solution 2 (2pLx N) + 6.4 pL

* N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.

Table 24 Multiplier to calculate the volume of Labeling Master Mix (for 4x microarrays
using non-FFPE and FFPE samples)*

Components Per reaction Total volume needed Volume to add per well of
(pL) 384 deep well plate

Nuclease-free water 35 (3.5 pLx N) +22.4 L

ULS-Cy3 or ULS-Cyb 0.5 (0.5 uLx N) +3.2 uL

10 x labeling solution 1 (TpLx N) +6.4 pL

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.
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Table 25  Multiplier to calculate the volume of Labeling Master Mix (for 8x microarrays
using non-FFPE and FFPE samples)*

Components Per reaction Total volume needed Volume to add per well of
(pL) 384 deep well plate

Nuclease-free water 3.75 (3.75 uLx N) + 24 pL

ULS-Cy3 or ULS-Cyb 0.25 (0.25 uyLx N) + 1.6 pL

10 x labeling solution 1 (TpLx N) +6.4 pL

Final volume of Labeling 5 (5 pL x N) + 32 pL ((5pLxN) +24pL) / 8

Master Mix

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.

2 In a 384 deep well plate:
Refer to Table 21 through Table 25 for volumes.

Add the Cyb Labeling Master Mix to 8 wells in quadrant 1 (location Al,
Cl, E1, G1, I1, K1, M1, and O1).

Add the Cy3 Labeling Master Mix to 8 wells in quadrant 3 (location B1,
D1, F1, H1, J1, L1, N1, and P1).

See Figure 5.

Make sure that no air bubbles are stuck at the bottom of the well. If needed,
spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls.
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Figure 5 384 deep well plate for ULS labeling. Well plate contains Cyb Labeling Master
Mix (blue) in quadrant 1 and Cy3 Labeling Master Mix (pink) in quadrant 3.

3 Put the 384 deep well plate at location 6 on the Bravo platform deck.
4 Start the FragmentationLabelingProtocol_ULS protocol run.

The Bravo platform transfers the correct amount of gDNA from the 96-well
plate that was prepared in Chapter 3, “Sample Preparation for Bravo
Platform” to the working plate.

5 When the Bravo platform pauses at the Protocol User Message task:

a Remove the gDNA sample plate from location 5. If needed, store the
leftover gDNA at 4°C for short term storage or at -20°C for long term
storage.

b Remove the working plate from location 4.

¢ Seal the plate and spin in a centrifuge for 30 seconds at 6,000 x g to drive
the contents off the walls and lid.

d Transfer the working plate to a thermocycler.

e Program the thermocycler according to Table 26 and run the program.
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Table 26 DNA fragmentation using a thermocycler

Step Temperature Time
Step 1 95°C 10 minutes
Step 2 4°C Hold

6 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

7 Remove the seal and transfer the working plate back to location 4 on the
Bravo platform deck.

8 Click Continue in the VWorks software.

The Bravo platform adds the Labeling Master Mix to the fragmented gDNA.
9 When the protocol run is finished:

a Remove the working plate from location 4.

b Seal the plate and spin in a centrifuge for 30 seconds at 6,000 x g to drive
the contents off the walls and lid.

¢ Transfer the working plate to a thermocycler.

d Program the thermocycler according to Table 27 and run the program.

Table 27 DNA labeling using a thermocycler

Step Temperature Time
Step 1 85°C 30 minutes
Step 2 4°C Hold

10 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

11 Keep the plate at 4°C in the dark until ready to do “Step 2. Purification
after ULS labeling” on page 53.
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Step 2. Purification after ULS labeling

In this step, the Bravo platform prepares the Agilent Genomic DNA 96-well
Purification Module, transfers the labeled DNA to the purification plate, then
you collect the labeled, purified DNA by centrifugation.

Bravo Platform  PurificationProtocol_ULS
Protocol Used

Initial Deck
Layout Location Content
1 Full tip box
4 Agilent reservoir containing nuclease-free water
7 When prompted: 96-well plate that contains the labeled gDNA
8 After step 4: Pre-spun purification plate/wash plate sandwich

Use the same centrifuge speed and length for all three spinning steps (step 3,
step 6 and step 10). If you spin only one plate, make sure that you
counterbalance the plate.

1 Carefully remove the top and bottom seals of the purification plate. Once
the bottom seal is removed, keep the plate on top of a wash plate. Do not
allow the bottom surface to come in contact with laboratory bench top
liners, wipes, or other materials.

2 Put the purification plate in a re-usable deep well wash plate (supplied).

3 Pre-spin the purification plate/wash plate sandwich in a centrifuge for 3
minutes at 3,000 x g.

4 Discard the flow-through from the wash plate, and put the purification
plate back on the same wash plate. Transfer the purification plate/wash
plate sandwich to location 8 on the Bravo platform.

5 Start the PurificationProtocol_ULS protocol run.

The Bravo platform adds water to the purification plate/wash plate
sandwich.

6 When the Bravo platform pauses at the Protocol User Message task, remove
the purification plate/wash plate sandwich from location 8 and spin again
in a centrifuge for 3 minutes at 3000 x g.
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71 Discard the flow-through.

8 Transfer the purification plate to a sample collection plate (supplied) and
transfer the purification plate/sample collection plate sandwich to location
8 on the Bravo platform. Put the 96-well plate containing the labeled gDNA
on location 7.

9 Click Continue in the VWorks software.

For 4x and 8x microarrays only, the Bravo platform adds water to the
labeled DNA. The Bravo platform transfers the labeled DNA to the
purification plate/sample collection plate sandwich.

10 When the Bravo protocol run is finished, remove the purification
plate/sample collection plate sandwich from location 8 and spin in a
centrifuge for 3 minutes at 3,000 x g to collect the purified labeled gDNA.
For 1x and 2x microarrays the volume per sample will be approximately 19
uL. For 4x and 8x microarrays the volume per sample will be approximately
12.5 uL.

11 Take 1.5 uL of each sample to determine the yield and degree of labeling.
See “To determine yield, degree of labeling or specific activity” on page 55.

12 For 8x microarrays only, use a vacuum concentrator to concentrate the
labeled samples to 4.5 uL. If needed, you can concentrate the labeled
samples to dryness and resuspend in 4.5 uL water.

Do not excessively dry the samples as the pellets will become difficult to resuspend.

13 Keep the plate at 4°C in the dark until ready for “Step 3. Preparation of ULS
Labeled Genomic DNA for Hybridization” on page 56.
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To determine yield, degree of labeling or specific activity

Use the 8-channel NanoDrop 8000 or single channel NanoDrop 2000 UV-VIS
Spectrophotometer to measure the yield, degree of labeling or specific activity.

1 From the main menu, select MicroArray Measurement, then select Sample
Type to be DNA-50.

2 Use 1.5 uL of 1x labeling solution (dilute 10x labeling solution 1:10) to blank
the instrument.

3 Mix the samples.

You mix the samples before you measure to get a more accurate
quantitation.

4 Use 1.5 uL of each labeled gDNA sample for quantitation. Measure the
absorbance at Aggy nm (DNA), As5o nm (cyanine 3), and Agso nm (cyanine
5).

5 Calculate the Degree of Labeling or Specific Activity of the labeled gDNA:

340 x pmol per uL dye
ng per uL genomic DNA x 1000

Degree of Labeling = x 100%

pmol per uL dye
Mg per UL genomic DNA

Specific Activity* =

*pmol dyes per ug genomic DNA
Note that the Specific Activity is Degree of Labeling divided by 0.034.

6 Record the gDNA concentration (ng/uL) for each sample. Calculate the yield
as

DNAconcentration (ng/ulL) - Sample Volume (uL)

Yi =
ield (ug) 1000 ng/ug

As a general guideline, an optimal Cy5 degree of labeling lies between 0.75%
and 2.5% and an optimal Cy3 degree of labeling lies between 1.75% and 3.5%,
with a Cy3 minus Cyb range between 1% and 2%. Because the ULS-labeling
does not copy or amplify the input DNA, the yield after the labeling should be
the same as the input amount of DNA.
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Step 3. Preparation of ULS Labeled Genomic DNA for

Hybridization

Bravo Platform
Protocol Used

Initial Deck
Layout

In this step, the Bravo platform combines the Cy3 and Cy5 samples and adds
the Hybridization Master Mix to the labeled purified DNA samples. You then
incubate the sample in a thermocycler, and the Bravo platform adds the

Agilent-CGHblock.

HybridizationPrepProtocol_ULS

Location 1x microarray 2x microarray 4x and 8x microarray
1 Empty tip box Empty tip box Empty tip box
2 Full tip box Full tip box Full tip box
4 V&P Scientific Reservoir: V&P Scientific Reservoir: V&P Scientific Reservoir:
* column 1: Hybridization = column 1: Hybridization < column 1: Hybridization
Master Mix Master Mix Master Mix
+ column 2: » column 2: + column 2:
Agilent-CGHblock Agilent-CGHblock Agilent-CGHblock
5 Tall-chimney plate
(ABgene p/n AB-1184)
placed in Eppendorf plate
(p/n 951020401)
7 Deep-well plate (ABgene
p/n AB-0859)
8 When you are prompted: When you are prompted: Working plate containing

Working plate containing
the labeled, purified DNA.

Working plate containing
the labeled, purified DNA.

the labeled, purified DNA
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1 Prepare the 100X Blocking Agent:

a Add 135 uL of nuclease-free water to the vial containing lyophilized 10X
CGH Blocking Agent (supplied with Agilent Oligo aCGH Hybridization
Kit).

b Mix briefly on a vortex mixer and leave at room temperature for 60
minutes to reconstitute the sample before use or storage.

¢ On the vial of lyophilized blocking agent, cross out “10X” and write
“100X”. For ULS labeled samples, you will be making and using 100X of
the blocking agent.

The 100X Blocking Agent can be prepared in advance and stored at -20°C.

2 Prepare the Hybridization Master Mix by mixing the components in the
tables below according to the microarray format used.

Table 28 Multiplier to calculate the volume of Hybridization Master Mix for 1x
microarrays, non-FFPE and FFPE samples*

Components Per reaction Total volume needed
(wL)

Nuclease-free water 39.8 (39.8 pLx N) + 157 pL

Cot-1 DNA (1.0 mg/mL)" 50 (50 pLx N) +197.2 uL

Agilent 100X Blocking Agent1 5.2 (5.2puL x N) +20.5 L

Agilent 2X Hi-RPM Hybridization Buffer' 260 (260 pL x N) +1025.4 L

Final Volume of Hybridization Master Mix 355 (355 pL x N) + 1400 pL

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count refer-
ence samples.

t Use Cot-1 DNA from the appropriate species.
1 Supplied with Agilent Oligo aCGH Hybridization Kit
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Table 29 Multiplier to calculate the volume of Hybridization Master Mix for 2x
microarrays, non-FFPE and FFPE samples*

Components Per reaction Total volume needed
Nuclease-free water 24 (24 pLx N) + 21 pL
Cot-1 DNA (1.0 mg/mL)T 25 (25 uLx N) +218.8 pL
Agilent 100X Blocking Agent1 2.6 (2.6 pLx N) +22.8 pL
Agilent 2X Hi-RPM Hybridization Buffer' 130 (130 uL x N) + 1137.5 uL
Final Volume of Hybridization Master Mix 160 (160 pL x N) + 1400 pL

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count refer-
ence samples.

t Use Cot-1 DNA from the appropriate species.
1 Supplied with Agilent Oligo aCGH Hybridization Kit

Table 30 Multiplier to calculate the volume of Hybridization Master Mix for 4x
microarrays, non-FFPE and FFPE samples*

Components Per reaction Total volume needed
(ui)

Cot-1 DNA (1.0 mg/mL)T 5 (5pLx N) +114.7 pL

Agilent 100X Blocking Agent1 1 (1 uLx N) +23.0 pL

Agilent 2X Hi-RPM Hybridization Buffer' b5 (55 uL x N) +1262.3 uL

Final Volume of Hybridization Master Mix 61 (61 pL x N) + 1400 pL

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count refer-
ence samples.

t Use Cot-1 DNA from the appropriate species.
1 Supplied with Agilent Oligo aCGH Hybridization Kit

Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform



DNA Labeling on the Bravo Platform

Table 31  Multiplier to calculate the volume of Hybridization Master Mix for 8x
microarrays, non-FFPE and FFPE samples*

Components Per reaction Total volume needed
(wL)

Cot-1 DNA (1.0 mg/mL)" 2 (2pLx N) + 112 pL

Agilent 100X Blocking Agent1 05 (0.5 uL x N) + 28 pL

Agilent 2X Hi-RPM Hybridization Buffer! 225 (22.5 L x N) + 1260 pL

Final Volume of Hybridization Master Mix 25 (25 pL x N) + 1400 pL

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count refer-
ence samples.

t Use Cot-1 DNA from the appropriate species.
1 Supplied with Agilent Oligo aCGH Hybridization Kit

3 Add hybridization mix to column 1 of the reservoir in location 4. Be careful

not to generate bubbles.

4 Use Table 32 to calculate how much Agilent-CGHblock (supplied with the
ULS Labeling Kit) to use.

Table 32 Multiplier to calculate volume of Agilent-CGHbIock*

Format Total volume needed
1x (130 pL x N) + 1400 pL
2x (65 pL x N) + 1400 pL
4x (27 pL x N) + 1400 pL
8x (11 pL x N) + 1400 pL

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48).
Do not count reference samples.

5 Bring the Agilent-CGHblock to room temperature.
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6 Add the Agilent-CGHblock to the 2nd column of the reservoir in location 4.

The addition of Agilent-CGHblock to the hybridization is needed to
eliminate background noise on the microarray. The Agilent-CGHblock
contains components that cannot be heated to 95°C.

7 Start the HybridizationPrepProtocol_ULS protocol run.

For 1x and 2x microarrays, the Bravo platform transfers the hybridization
master mix to the empty deep-well or tall-chimney plates. Continue at
step 8.

For 4x and 8x microarrays, the Bravo platform combines the Cy5 and Cy3
labeled, purified samples and adds the hybridization master mix. Continue
at step 9.

8 For 1x and 2x microarrays:

a When the Bravo platform pauses at the Protocol User Message task, put
the working plate that contains the labeled, purified DNA at location 8.

b Click Continue in the VWorks software.

The Bravo platform adds the Cy3 and Cy5 labeled, purified gDNA to the
hybridization master mix.

When the number of samples is greater than 40, the Bravo platform runs out of tips before
the end of the protocol run.

If you see the error message Error in automatic tip operation, put more tips into the Bravo
platform. Go to Tools > Tip State Editor, and update the status of the tip boxes.

9 When the Bravo platform pauses at the Protocol User Message task:

a Remove, seal and transfer the deep-well plate from location 7,
tall-chimney plate from location 5, or the PCR plate from location 8 to a
thermocycler.

b Program the thermocycler according to Table 33 and run the program.

For the 1x microarray deep-well plates, use an incubator that is compatible
with deep-well plates, such as the Eppendorf ThermoStat plus (Eppendorf
p/n 022670204 with deep-well plate block p/n 022670565).
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Table 33 DNA preparation before hybridization

Step Temperature Time
Step 1 95°C 3 minutes
Step 2 37°C 30 minutes

10 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

11 Remove the seal and transfer the deep-well plate back to location 7,
tall-chimney plate back to location 5, or the PCR plate back to location 8 on
the Bravo platform deck.

12 Click Continue in the VWorks software.
The Bravo platform adds the Agilent-CGHblock to the samples.

The samples are ready for the Hybridization step. Continue at Chapter 5,
“Microarray Processing and Feature Extraction.”
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Enzymatic Labeling for CGH

Follow the procedure in this section if you are using Enzymatic labeling for
CGH.

Step 1. Enzymatic Labeling

In this step, the Bravo platform transfers the correct amount of gDNA from the
96-well plate that was prepared in Chapter 3, “Sample Preparation for Bravo
Platform” to the working plate. You denature and fragment the gDNA in the
presence of random primers in a thermocycler, the Bravo platform adds the
Labeling Master Mix to the fragmented gDNA, and the labeling reactions are
done in a thermocycler.

Bravo Platform  FragmentationLabelingProtocol_Enz

Protocol
Initial Deck
Layout Location Content

1and7 Empty tip box
2and 8 Full tip box
5 Sample plate containing the gDNA (prepared in Chapter 3)
4 (cooled) Empty working plate (Eppendorf p/n 951020401)
6 (cooled) 384 deep well plate:

* Random primers in quadrant 1
+ Cyb5 Labeling Master Mix in quadrant 2
+ Cy3 Labeling Master Mix in quadrant 4

1 Turn on the Bravo Platform CPAC Ultraflat heated/cooled Deck Pads on
Positions 4 and 6, set to 4°C.

2 Use Table 34 to calculate how much Random Primers (supplied with the
Agilent Genomic DNA Enzymatic Labeling Kit) to use.
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Table 34  Multiplier to calculate volume of Random Primer’

Format Total volume needed Volume to add per well of 384
deep well plate

1x, 2x or 4x (5puLxNx2)+32pL (BpLxNx2)+24pL)/8
8x (25puLx N x 2) + 32 pL (2.5 pLx N x 2) + 24 uL)/8

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.

3 Refer to Table 34 for volumes. Add the Random Primers to 8 wells in
quadrant 1 (location Al, C1, E1, G1, I1, K1, M1, and O1). See Figure 6.

Make sure that no air bubbles are stuck at the bottom of the well. If needed,
spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls.
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Figure 6 384 deep well plate for Enzymatic labeling containing Random Primer (gray) in
quadrant 1, Cy5 Labeling Master Mix (blue) in quadrant 2 and Cy3 Labeling
Master Mix (pink) in quadrant 4

4 Prepare one Cy3 and one Cy5 Labeling Master Mix by mixing the
components in Table 35 and Table 36, based on your microarray format.
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5 In a 384 deep well plate:
Refer to Table 35 and Table 36 for volumes.

Add the Cyb Labeling Master Mix to 8 wells in quadrant 2 (location A2,
C2, E2, G2, 12, K2, M2, and 02).

Add the Cy3 Labeling Master Mix to 8 wells in quadrant 4 (location B2,
D2, F2, H2, J2, L2, N2, and P2).

See Figure 6.

Make sure that no air bubbles are stuck at the bottom of the well. If needed,
spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls.

6 Put the 384 deep well plate at location 6 on the Bravo platform deck.

Protect the 5X Buffer from light. Although exposure to light does not affect the performance
of the 5X Buffer, the buffer can change to a yellow color.

Table 35 Multiplier to calculate the volume of Labeling Master Mix (for 1x, 2x and 4x
microarrays)*

Component Per reaction Total volumes Volume to add per well
(pL) needed of 384 deep well plate

Nuclease-free water 1 (TpuLx N) +2.1 pL

5X Buffer 5 (5uLx N)+10.7 pL

10X dNTP Mix' 5 (5pLx N) +10.7 pL

Cyanine 3-dUTP (1.0 mM) 3 (3uLx N) +6.4 uL

or

Cyanine 5-dUTP (1.0 mM)

Exo-Klenow fragment 1 (TpuLx N) +2.1 L
Final volume of Labeling 15 (15pLxN) +32pL  ((15pLxN) +24 pL)/8
Master Mix

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference sam-
ples.

t used as a 5X dNTP mix
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Table 36  Multiplier to calculate the volume of Labeling Master Mix (for 8x microarrays)

Component Per reaction Total volumes needed Volume to add per well of
(pL) 384 deep well plate

Nuclease-free water 9 (9 uLx N) +15.6 pL

5X Buffer 5 (5pLx N) +8.6 pL

10X dNTP Mix 25 (25 pLx N) + 4.3 pL

Cyanine 3-dUTP (1.0 mM) 15 (1.5 uLx N) + 2.6 uL

or

Cyanine 5-dUTP (1.0 mM)

Exo-Klenow fragment 0.5 (0.5puLx N)+ 0.9 pL
Final volume of Labeling 18.5 (185pLxN) +32pL ((18.5pLx N) + 24 pL)/8
Master Mix

7 Start the FragmentationLabelingProtocol_Enz protocol run.

The Bravo platform adds the Random Primers to the empty working plate.
The Bravo platform transfers the correct amount of gDNA from the 96-well
plate that was prepared in Chapter 3, “Sample Preparation for Bravo
Platform” to the working plate.

8 When the Bravo platform pauses at the Protocol User Message task:

a Remove the gDNA sample plate from location 5. If needed, store the
leftover gDNA at 4°C for short term storage or at -20°C for long term
storage.

b Remove the working plate from location 4.

¢ Seal the plate and spin in a centrifuge for 30 seconds at 6,000 x g to drive
the contents off the walls and lid

d Transfer the working plate to a thermocycler.

e Program the thermocycler according to Table 37 and run the program.

Table 37 DNA fragmentation using a thermocycler

Step Temperature Time
Step 1 95°C 10 minutes
Step 2 4°C Hold
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9 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

10 Remove the seal and transfer the working plate back to location 4 on the
Bravo platform deck.

11 Click Continue in the VWorks software.

The Bravo platform adds the Labeling Master Mix to the fragmented gDNA.
When the number of samples is greater than 40, the Bravo platform runs out of tips before
the end of the protocol run.

If you see the error message Error in automatic tip operation, put more tips into the Bravo
platform. Go to Tools > Tip State Editor, and update the status of the tip boxes.

12 When the protocol run is finished:
a Remove the working plate from location 4.

b Seal the plate and spin in a centrifuge for 30 seconds at 6,000 x g to drive
the contents off the walls and lid.

¢ Transfer the working plate to a thermocycler.

d Program the thermocycler according to Table 38 and run the program.

Table 38 DNA labeling using a thermocycler

Step Temperature Time

Step 1 37°C 2 hours
Step 2 65°C 10 minutes
Step 3 4°C Hold

13 Turn off the Bravo Platform CPAC Ultraflat heated/cooled Deck Pads on
Positions 4 and 6.

14 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

15 Keep the plate at 4°C in the dark until ready to do “Step 2. Purification
after Enzymatic labeling” on page 67.
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Step 2. Purification after Enzymatic labeling

In this step, the Bravo platform prepares the AutoScreen-96A Well plates,
transfers the labeled DNA to the purification plate, then you collect the labeled
purified DNA by centrifugation.

Bravo Platform  PurificationProtocol_Enz
Protocol Used

Initial Deck
Layout Location Content
1 Full tip box
4 Agilent reservoir containing nuclease-free water
7 When prompted: 96-well plate containing the labeled gDNA
8 After step 6: Pre-spun purification plate/wash plate sandwich

Use the same centrifuge speed and length for all three spinning steps (step 5,
step 8 and step 12). If you spin only one plate, make sure that you
counterbalance.

1 Get a 96-well PCR plate (Eppendorf p/n 951020401) to use as a wash plate,
and label it as “Wash Plate”.

The wash plate can be reused.

2 Get another 96-well PCR plate to use as a collection plate, and label it as
“Collection Plate”.

3 Carefully remove the top and bottom seals of the purification plate. Once
the bottom seal is removed, keep the plate on top of a wash plate. Do not
allow the bottom surface to come in contact with laboratory bench top
liners, wipes, or other materials.

4 Put the purification plate in a reusable wash plate.

5 Pre-spin the purification plate/wash plate sandwich in a centrifuge for 5
minutes at 910 x g.

6 Discard the flow-through from the wash plate and put the purification plate
back on the same wash plate. Transfer the purification plate/wash plate
sandwich to location 8 on the Bravo platform.

7 Start the PurificationProtocol_Enz protocol run.
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The Bravo platform adds water to the purification plate/wash plate
sandwich.

8 When the Bravo platform pauses at the Protocol User Message task, remove
the purification plate/wash plate sandwich from location 8 and spin again
in a centrifuge for 5 minutes at 910 x g.

9 Discard the flow-through.

10 Transfer the purification plate to a sample collection plate and transfer the
purification plate/sample collection plate sandwich to location 8 on the
Bravo platform. Put the 96-well plate containing the labeled gDNA on
location 7.

11 Click Continue in the VWorks software.

The Bravo platform transfers the labeled DNA to the purification
plate/sample collection plate sandwich.

12 When the protocol run is finished, remove the purification plate/sample
collection plate sandwich from location 8 and spin in a centrifuge for 5
minutes at 910 x g to collect the purified labeled gDNA in the sample
collection plate. The volume per sample will be 719 uL.

13 Take 1.5 uL of each sample to determine the yield and degree of labeling or
specific activity. See “To determine yield, degree of labeling or specific
activity” on page 69.

14 For 8x microarrays only, use a vacuum concentrator to concentrate the
labeled samples to 8 uL. If needed, you can concentrate the labeled samples
to dryness and resuspend in 8 uL water.

Do not excessively dry the samples, or the pellets become difficult to resuspend.

15 Keep the plate at 4°C in the dark until ready for “Step 3. Preparation of
Enzymatic Labeled Genomic DNA for Hybridization” on page 71.
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To determine yield, degree of labeling or specific activity

Use the 8-channel NanoDrop 8000 or single channel NanoDrop 2000 UV-VIS
Spectrophotometer to measure yield, degree of labeling or specific activity.

1 From the main menu, select MicroArray Measurement, then select Sample
Type to be DNA-50.

2 Use 1.5 uL of TE to blank the instrument.
3 Mix the samples.

You mix the samples before you measure to get a more accurate
quantitation.

4 Use 1.5 uL of each labeled gDNA sample for quantitation. Measure the
absorbance at Aggy nm (DNA), A5 nm (cyanine 3), and Agso nm (cyanine
5).

5 Calculate the Degree of Labeling or Specific Activity of the labeled gDNA:

340 x pmol per uL dye
ng per uL genomic DNA x 1000

Degree of Labeling = x 100%

pmol per uL dye
Mg per UL genomic DNA

Specific Activity* =

*pmol dyes per ug genomic DNA
Note that the Specific Activity is Degree of Labeling divided by 0.034.

6 Record the gDNA concentration (ng/uL) for each sample. Calculate the yield
as

DNAconcentration (ng/ulL) - Sample Volume (uL)
1000 ng/ug

Yield (ug) =
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Refer to Table 39 for expected yield of labeled genomic DNA and specific
activity after labeling and clean-up, when starting with high quality genomic
DNA.

Table 39 Expected Yield and Specific Activity after Labeling and Clean-up

Input gDNA (pg) Yield (pg) Specific Activity of Specific Activity of
Cyanine-3 Labeled Cyanine-b Labeled
Sample (pmol/pg) Sample (pmol/pg)

0.5 45t055 15t0 25 15t0 20

02 25t03 15 to 25 15 to 20

*

Half labeling reaction (half the amount of random primers, dye, enzyme and dNTPs)

Check that the Cy3 and Cyb yield after labeling are the same. If not, refer to
“Troubleshooting” on page 121.
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Step 3. Preparation of Enzymatic Labeled Genomic DNA for
Hybridization

1

In this step, the Bravo platform combines the Cy3 and Cy5 samples, adds the
Hybridization Master Mix to the labeled purified DNA samples, and you
incubate the sample in a thermocycler.

HybridizationPrepProtocol_Enz

Location 1x microarray 2x microarray 4x and 8x microarray
1 Empty tip box Empty tip box Empty tip box
2 Full tip box Full tip box Full tip box
4 V&P Scientific Reservoir: V&P Scientific Reservoir: V&P Scientific Reservoir:
* column 1: Hybridization = column 1: Hybridization ~ + column 1: Hybridization
Master Mix Master Mix Master Mix
* If number of samples >
32, column 2:
Hybridization Master
Mix
5 Tall-chimney plate
(ABgene p/n AB-1184)
placed in Eppendorf plate
(p/n 951020401)
7 Deep-well plate (ABgene
p/n AB-0859)
8 When you are prompted: When you are prompted: Working plate containing

Working plate containing
the labeled, purified DNA.

Working plate containing
the labeled, purified DNA.

the labeled, purified DNA.
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1 Prepare the 10X Blocking Agent:

a Add 1350 uL of nuclease-free water to the vial containing lyophilized 10X
CGH Blocking Agent (supplied with Agilent Oligo aCGH Hybridization
Kit).

b Mix briefly on a vortex mixer and leave at room temperature for 60
minutes to reconstitute the Blocking Agent before use or storage.

The 10X Blocking Agent can be prepared in advance and stored at -20°C.

2 Prepare the Hybridization Master Mix by mixing the components in the
tables below according to the microarray format used.

Table 40  Multiplier to calculate the volume of Hybridization Master Mix for 1x
microarrays*

Component Per Total volume needed Additional volume needed in
reaction incolumn1ifN <=32 column2ifN > 32
(nL)
1XTE 123 (123 uLx N) +355.1 pL (123 pL x (N-32)) + 355.1 pL
Cot-1 DNA (1.0 mg/mL)" 50 (50 uLx N) +144.3 uL (50 pL x (N-32)) + 144.3 pL
Agilent 10X Blocking AgentI 52 (52 uLx N) +150.1 pL (52 pL x (N-32)) + 150.1 pL
Agilent 2X Hi-RPM 260 (260 uLx N) +750.5 uL (260 pL x (N-32)) + 750.5 pL
Hybridization Buffer'
Final Volume of 485 (485 pL x N) + 1400 uL (485 pL x (N-32)) + 1400 pL

Hybridization Master Mix

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.
t Use Cot-1 DNA from the appropriate species.
1 Supplied with Agilent Oligo aCGH Hybridization Kit
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Step 3. Preparation of Enzymatic Labeled Genomic DNA for Hybridization

Table 41  Multiplier to calculate the volume of Hybridization Master Mix for 2x
microarrays

Component Per reaction (pL) Total volume needed
1XTE 44 (44 uLx N) +273.8 pL
Cot-1 DNA (1.0 mg/mL)’ 25 (25 pL x N) + 155.6 pL
Agilent 10X Blocking Agent’ 26 (26 uLx N) +161.8 pL
Agilent 2X Hi-RPM 130 (130 pL x N) + 808.9 pL

Hybridization Buffer’

*

Use Cot-1 DNA from the appropriate species.
t Supplied with Agilent Oligo aCGH Hybridization Kit

Table 42  Multiplier to calculate the volume of Hybridization Master Mix for 4x
microarrays

Component Per reaction (pL) Total volume needed
1IXTE 4 (4 pLx N) +74.7uL
Cot-1 DNA (1.0 mg/mL)’ 5 (5pLx N)+93.3 uL
Agilent 10X Blocking AgentT " (11 uLx N) +205.3 pL
Agilent 2X Hi-RPM 55 (55 puL x N) +1026.7 pL

Hybridization Buffer'

*

Use Cot-1 DNA from the appropriate species.
t Supplied with Agilent Oligo aCGH Hybridization Kit
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Table 43  Multiplier to calculate the volume of Hybridization Master Mix for 8x

microarrays

Component Per reaction (pL) Total volume needed
Cot-1 DNA (1.0 mg/mL)’ 2 (2puLx N) +96.6 pL
Agilent 10X Blocking AgentJr 45 (45 uLxN)+217.2 L
Agilent 2X Hi-RPM 225 (22.5 uL x N) +1086.2 pL

Hybridization Buffer'

Final Volume of 29 (29 pL x N) + 1400 pL
Hybridization Master Mix

*

1

Use Cot-1 DNA from the appropriate species.
Supplied with Agilent Oligo aCGH Hybridization Kit

Add hybridization mix to the reservoir in location 4. Be careful not to
generate bubbles.

For 1x and £ 32 samples, 2x, 4x and 8x: add to column 1.
For 1x and > 32 samples: add to column 1 and 2.
Start the HybridizationPrepProtocol_Enz protocol run.

For 1x and 2x microarrays, the Bravo platform transfers the hybridization
master mix to the empty deep-well or tall-chimney plates. Continue at
step 5.

For 4x and 8x microarrays, the Bravo platform combines the Cy5 and Cy3
labeled, purified samples and adds the hybridization master mix. Continue
at step 6.

For 1x and 2x microarrays:

a When the Bravo platform pauses at the Protocol User Message task, put
the working plate that contains the labeled, purified DNA at location 8.

b Click Continue in the VWorks software.

The Bravo platform adds the Cy3 and Cyb labeled, purified gDNA to the
hybridization master mix.
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When the number of samples is greater than 40, the Bravo platform runs out of tips before
the end of the protocol run.

If you see the error message Error in automatic tip operation, put more tips into the Bravo
platform. Go to Tools > Tip State Editor, and update the status of the tip boxes.

6 When the protocol run is finished, remove, seal, spin, and transfer the
deep-well plate from location 7, tall-chimney from location 5, or the PCR
plate from location 8 to a thermocycler. Program the thermocycler
according to Table 44 and run the program.

For the 1x microarray deep-well plates, use an incubator that is compatible
with deep-well plates, such as the Eppendorf ThermoStat plus (Eppendorf
p/n 022670204 with deep-well plate block p/n 022670565).

Table 44 DNA preparation before hybridization

Step Temperature Time
Step 1 95°C 3 minutes
Step 2 37°C 30 minutes

7 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

The samples are ready for the Hybridization step.
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Enzymatic Labeling for CGH+SNP

Bravo Platform
Protocol

Initial Deck
Layout

76

Follow the procedure in this section if you are using Enzymatic labeling for
CGH+SNP.

Step 1. Enzymatic Labeling

In this step, the Bravo platform combines the correct amount of gDNA from
the 96-well plate that was prepared in Chapter 3, “Sample Preparation for
Bravo Platform” with the Restriction Digestion Master Mix in the working
plate. The gDNA is denatured in the presence of random primers in a
thermocycler, the Bravo platform adds the Labeling Master Mix to the digested
gDNA, and the labeling reactions are done in a thermocycler.

CGH+SNP_RestrictionDigestionLabelingProtocol_Enz

Location Content

1and7 Empty tip box

2and 8 Full tip box

5 Sample plate containing the gDNA (prepared in Chapter 3)
4 (cooled) Empty working plate (Eppendorf p/n 951020401)

6 (cooled) 384 deep well plate:

+ Restriction Digestion Master Mix in quadrant 3

* Only when prompted: Random Primers and Labeling Master Mix
Random Primers in quadrant 1
Cyb5 Labeling Master Mix in quadrant 2
Cy3 Labeling Master Mix in quadrant 4

1 Turn on the Bravo Platform CPAC Ultraflat heated/cooled Deck Pads on
Positions 4 and 6, set to 4°C.

2 Prepare the Restriction Digestion Master Mix by mixing the components in
Table 45 and Table 46, based on your microarray format.
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Table 45 Multiplier to calculate the volume of Restriction Digestion Master Mix (for 1x, 2x

and 4x microarrays)

Components Per reaction Total Vo!umes Volume to add per well of
(pL) Needed 384 deep well plate

Nuclease-free water 2.2 (22puLxNx2)+11.7

10x Reaction buffer C 2.6 (26 pLxNx2)+13.9

Acetylated BSA 0.2 (0.2pLxNx2)+1.1

Alul 05 (0.5pLxNx2)+2.7

Rsal 0.5 (0.5pLxNx2)+2.7

Final volume of Restriction 6
Digestion Master Mix

(6uLxNx2)+32  ((6pLxNx2)+24pL)/8

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.

Table 46  Multiplier to calculate the volume of Restriction Digestion Master Mix (for 8x

microarrays)

Components Per Total Volumes Needed Volume to add per well of
reaction 384 deep well plate
(mL)

Nuclease-free water 41 (41pLxNx2)+21.9

10x Reaction buffer C 1.3 (1.3pLxNx2)+6.9

Acetylated BSA 0.1 (0.TpLxNx2)+0.5

Alul 0.25 (025 uLxNx2)+1.3

Rsal 0.25 (0.25pLxNx2)+1.3

Final volume of Restriction 6
Digestion Master Mix

(6pLx N x2) + 32 ((6pLxNx2)+24puL)/8

3 In a 384 deep well plate, add Restriction Digestion Master Mix to 8 wells in
quadrant 3 (location B1, D1, F1, H1, J1, L1, N1, and P1). See Figure 7.
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Figure 7 384 deep well plate for CGH+SNP Enzymatic Labeling containing Restriction
Digestion Master Mix in quadrant 3

4 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and to remove any bubbles that are stuck at the
bottom of the well.

5 Put the 384 deep well plate at location 6 on the Bravo platform deck.

6 Start the CGH+SNP_RestrictionDigestionLabelingProtocol_Enz protocol
run.

The Bravo platform adds the Restriction Digestion Master Mix to the empty
working plate. The Bravo platform transfers the correct amount of gDNA
from the 96-well plate that was prepared in Chapter 3, “Sample Preparation
for Bravo Platform” to the working plate.

7 When the Bravo platform pauses at the Protocol User Message task:

a Remove the gDNA sample plate from location 5. If needed, store the
leftover gDNA at 4°C for short term storage, or at -20°C for long term
storage.

b Remove the working plate from location 4.

¢ Seal the plate and spin in a centrifuge for 30 seconds at 6,000 x g to drive
the contents off the walls and lid.

d Transfer the working plate to a thermocycler.

e Program the thermocycler according to Table 47 and run the program.
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Table 47 DNA restriction digestion using a thermocycler

Step Temperature Time

Step 1 37°C 2 hours
Step 2 65°C 10 minutes
Step 3 4°C Hold

8 When the incubation is finished, remove the plate from the thermocycler
and spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lids.

Keep the plate at 4°C until ready to continue to the addition of Random
Primers and Labeling Master Mix.

9 Use Table 48 to calculate how much Random Primers (supplied with the
Agilent Genomic DNA Enzymatic Labeling Kit) to use.

Table 48  Multiplier to calculate volume of Random Primer’

Format Total volume needed Volume to add per well of 384
deep well plate

1x, 2x or 4x (5puLxNx2)+32pL (BpLxNx2)+24pL)/8

8x (25puLxNx 2) + 32 pL (2.5 pLx N x 2) +24 uL)/8

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.

10 Refer to Table 48 for volumes. Add the Random Primers to 8 wells in
quadrant 1 (location Al, C1, E1, G1, I1, K1, M1, and O1). See Figure 8.

Make sure that no air bubbles are stuck at the bottom of the well. If needed,
spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls.
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Figure 8 384 deep well plate for Enzymatic labeling containing Random Primer (gray) in
quadrant 1, Cy5 Labeling Master Mix (blue) in quadrant 2 and Cy3 Labeling
Master Mix (pink) in quadrant 4

11 Prepare one Cy3 and one Cyb Labeling Master Mix by mixing the
components in Table 49 and Table 50, based on your microarray format.

12 In the 384 deep well plate:
Refer to Table 49 and Table 50 for volumes.

Add the Cyb Labeling Master Mix to 8 wells in quadrant 2 (location A2,
C2, E2, G2, 12, K2, M2, and 02).

Add the Cy3 Labeling Master Mix to 8 wells in quadrant 4 (location B2,
D2, F2, H2, J2, L2, N2, and P2).

See Figure 8.

Make sure that no air bubbles are stuck at the bottom of the well. If needed,
spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls.

13 Put the 384 deep well plate at location 6 on the Bravo platform deck.

Protect the 5X Buffer from light. Although exposure to light does not affect the performance
of the 5X Buffer, the buffer can change to a yellow color.
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Table 49  Multiplier to calculate the volume of Labeling Master Mix (for 1x, 2x and 4x
microarrays)*

Component Per reaction Total volumes Volume to add per well
(pL) needed of 384 deep well plate

5X Buffer 10 (10 uLx N) +16.8 pL

10X dNTP Mix' 5 (5 pLx N) + 8.4 pL

Cyanine 3-dUTP (1.0 mM) 3 (3puLx N) +5.1 uL

or

Cyanine 5-dUTP (1.0 mM)

Exo-Klenow fragment 1 (TpLx N) + 1.7 pL
Final volume of Labeling 19 (19pLxN) +32pL  ((19pLxN) +24 pL)/8
Master Mix

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference sam-
ples.

t used as a 5X dNTP mix

Table 50 Multiplier to calculate the volume of Labeling Master Mix (for 8x microarrays)

Component Per reaction Total volumes needed Volume to add per well of
(pL) 384 deep well plate

5X Buffer 5 (5uLx N)+16.8 uL

10X dNTP Mix 25 (25 uLx N) + 8.4 L

Cyanine 3-dUTP (1.0mM) 1.5 (1.5 pLx N) +5.1 uL

or

Cyanine 5-dUTP (1.0 mM)

Exo-Klenow fragment 0.5 (0.5 puLx N) + 1.7 pL
Final volume of Labeling 9.5 (95pLxN) +32pL  ((9.5pLx N) +24 pL)/8
Master Mix

14 Remove the seal and transfer the working plate back to location 4 on the
Bravo platform deck.

15 Press the Go button to continue the
CGH+SNP_RestrictionDigestionLabelingProtocol_Enz protocol run.
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The Bravo platform adds the Random Primers to the working plate that
contains the digested gDNA.

16 When the Bravo platform pauses at the Protocol User Message task:
a Remove the working plate from location 4.

b Seal the plate and spin in a centrifuge for 30 seconds at 6,000 x g to drive
the contents off the walls and lid.

¢ Transfer the working plate to a thermocycler.

d Program the thermocycler according to Table 51 and run the program.

Table 51 DNA denaturation using a thermocycler

Step Temperature Time
Step 1 95°C 3 minutes
Step 2 4°C Hold

17 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

18 Remove the seal and transfer the working plate back to location 4 on the
Bravo platform deck.

19 Click Continue in the VWorks software.
The Bravo platform adds the Labeling Master Mix to the digested gDNA.

When the number of samples is 24 or greater, the Bravo platform runs out of tips before the
end of the protocol run.

If you see the error message Error in automatic tip operation, put more tips into the Bravo
platform. Go to Tools > Tip State Editor, and update the status of the tip boxes.

20 When the protocol run is finished:
a Remove the working plate from location 4.

b Seal the plate and spin in a centrifuge for 30 seconds at 6,000 x g to drive
the contents off the walls and lid.

¢ Transfer the working plate to a thermocycler.

d Program the thermocycler according to Table 52 and run the program.
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Table 52 DNA labeling using a thermocycler

Step Temperature Time

Step 1 37°C 2 hours
Step 2 65°C 10 minutes
Step 3 4°C Hold

21 Turn off the Bravo Platform CPAC Ultraflat heated/cooled Deck Pads on
Positions 4 and 6.

22 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

23 Keep the plate at 4°C in the dark until ready to do “Step 2. Purification
after Enzymatic labeling” on page 67.
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Step 2. Purification after Enzymatic labeling

In this step, the Bravo platform prepares the AutoScreen-96A Well plates,
transfers the labeled DNA to the purification plate, then you collect the labeled
purified DNA by centrifugation.

Bravo Platform CGH+SNP_PurificationProtocol_Enz
Protocol Used

Initial Deck
Layout Location Content
1 Full tip box
4 Agilent reservoir containing nuclease-free water
7 When prompted: 96-well plate containing the labeled gDNA
8 After step 6: Pre-spun purification plate/wash plate sandwich

Use the same centrifuge speed and length for all spinning steps (step 5, step 8,
step 12 and step 14). If you spin only one plate, make sure that you
counterbalance.

1 Get a 96-well PCR plate (Eppendorf p/n 951020401) to use as a wash plate,
and label it as “Wash Plate”.

The wash plate can be reused.

2 Get another 96-well PCR plate to use as a collection plate, and label it as
“Collection Plate”.

3 Carefully remove the top and bottom seals of the purification plate. Once
the bottom seal is removed, keep the plate on top of a wash plate. Do not
allow the bottom surface to come in contact with laboratory bench top
liners, wipes, or other materials.

4 Put the purification plate in a reusable wash plate.

5 Pre-spin the purification plate/wash plate sandwich in a centrifuge for 5
minutes at 910 x g.

6 Discard the flow-through from the wash plate and put the purification plate
back on the same wash plate. Transfer the purification plate/wash plate
sandwich to location 8 on the Bravo platform.
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71 Start the CGH+SNP_PurificationProtocol_Enz protocol run. You are
prompted to choose the microarray format.

The Bravo platform adds water to the purification plate/wash plate
sandwich.

8 When the Bravo platform pauses at the Protocol User Message task, remove
the purification plate/wash plate sandwich from location 8 and spin again
in a centrifuge for 5 minutes at 910 x g.

9 Discard the flow-through.

10 Transfer the purification plate to a sample collection plate and transfer the
purification plate/sample collection plate sandwich to location 8 on the
Bravo platform. Put the 96-well plate containing the labeled gDNA on
location 7.

11 Click Continue in the VWorks software.

The Bravo platform transfers 25 uL of the labeled DNA to the purification
plate/sample collection plate sandwich.

12 Remove the purification plate/sample collection plate sandwich from
location 8 and spin in a centrifuge for 5 minutes at 910 x g to collect the
purified labeled gDNA in the sample collection plate. The volume per
sample will be 719 uL.

For 1x, 2x, or 4x array formats, return the purification plate/sample
collection plate sandwich to location 8.

Make sure the plate is positioned in the deck in the same orientation as in the step
before. Otherwise, the Cy5-labeled and Cy3-labeled samples will get mixed.

13 Click Continue in the VWorks software.

The Bravo platform transfers the remaining 25 uL of labeled DNA to the
same purification plate/sample collection plate sandwich.

14 When the protocol run is finished, remove the purification plate/sample
collection plate sandwich from location 8 and spin in a centrifuge for
5 minutes at 910 x g to collect the purified labeled gDNA in the sample
collection plate.

The recovered volume per sample will be approximately 19 uL. The total
recovered volume per sample will be approximately 38 uL.

Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform 85



4 DNA Labeling on the Bravo Platform

15 Take 1.5 uL of each sample to determine the yield and degree of labeling or
specific activity. See “To determine yield, degree of labeling or specific
activity” on page 87.

16 For 4x and 8x microarrays, use a vacuum concentrator to concentrate the
labeled samples:

For 8x microarrays, concentrate to 8 uL. If needed, concentrate the
labeled samples to dryness and resuspend in 8 uL.

For 4x microarrays, concentrate to 24.5 uL. If needed, concentrate the
labeled samples to dryness and resuspend in 24.5 uL water.

As an alternative, transfer 24.5 uL of each experimental and reference
labeled DNA to a new plate that will be used for Hybridization
preparation. In this case, not all labeled DNA will be hybridized, and
consequently the signals will be lower.

Do not excessively dry the samples, or the pellets becomes difficult to resuspend.

17 Keep the plate at 4°C in the dark until ready for “Step 3. Preparation of
Enzymatic Labeled Genomic DNA for Hybridization” on page 89.
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To determine yield, degree of labeling or specific activity

Use the 8-channel NanoDrop 8000 or single channel NanoDrop 2000 UV-VIS
Spectrophotometer to measure yield, degree of labeling or specific activity.

1 From the main menu, select MicroArray Measurement, then select Sample
Type to be DNA-50.

2 Use 1.5 uL of TE to blank the instrument.
3 Mix the samples.

You mix the samples before you measure to get a more accurate
quantitation.

4 Use 1.5 uL of each labeled gDNA sample for quantitation. Measure the
absorbance at Aggy nm (DNA), A5 nm (cyanine 3), and Agso nm (cyanine
5).

5 Calculate the Degree of Labeling or Specific Activity of the labeled gDNA:

340 x pmol per uL dye
ng per uL genomic DNA x 1000

Degree of Labeling = x 100%

pmol per uL dye
Mg per UL genomic DNA

Specific Activity* =

*pmol dyes per ug genomic DNA
Note that the Specific Activity is Degree of Labeling divided by 0.034.

6 Record the gDNA concentration (ng/uL) for each sample. Calculate the yield
as

DNAconcentration (ng/ulL) - Sample Volume (uL)
1000 ng/ug

Yield (ug) =
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Refer to Table 53 for expected yield of labeled genomic DNA and specific
activity after labeling and clean-up, when starting with high quality genomic
DNA.

Table 53  Expected Yield and Specific Activity after Labeling and Clean-up

Input gDNA (pg) Yield (pg) Specific Activity of Specific Activity of
Cyanine-3 Labeled Cyanine-b Labeled
Sample (pmol/pg) Sample (pmol/pg)

1 751010 121022 10 to 20
05 2.5t04.5 1510 20 12t0 17

*

Half labeling reaction (half the amount of random primers, dye, enzyme and dNTPs)

Check that the Cy3 and Cyb yield after labeling are the same. If not, refer to
“Troubleshooting” on page 121.
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Bravo Platform
Protocol Used

Initial Deck
Layout

DNA Labeling on the Bravo Platform

Step 3. Preparation of Enzymatic Labeled Genomic DNA for
Hybridization

1

In this step, the Bravo platform combines the Cy3 and Cy5 samples, adds the
Hybridization Master Mix to the labeled purified DNA samples, and you
incubate the sample in a thermocycler.

CGH+SNP_HybridizationPrepProtocol_Enz

Location 1x microarray 2x microarray 4x and 8x microarray
1 Empty tip box Empty tip box Empty tip box
2 Full tip box Full tip box Full tip box
4 V&P Scientific Reservoir: V&P Scientific Reservoir: V&P Scientific Reservoir:
* column 1: Hybridization = column 1: Hybridization ~ + column 1: Hybridization
Master Mix Master Mix Master Mix
* If number of samples >
32, column 2:
Hybridization Master
Mix
5 Tall-chimney plate
(ABgene p/n AB-1184)
placed in Eppendorf plate
(p/n 951020401)
7 Deep-well plate (ABgene
p/n AB-0859)
8 When you are prompted: When you are prompted: Working plate containing

Working plate containing
the labeled, purified DNA.

Working plate containing
the labeled, purified DNA.

the labeled, purified DNA.
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1 Prepare the 100X Blocking Agent:

a Add 135 uL of nuclease-free water to the vial containing lyophilized 10X
CGH Blocking Agent (supplied with Agilent Oligo aCGH Hybridization
Kit).

b Mix briefly on a vortex mixer and leave at room temperature for 60
minutes to reconstitute the sample before use or storage.

¢ On the vial of lyophilized blocking agent, cross out “10X” and write
“100X”. For labeled samples that will hybridize to CGH+SNP arrays, you
make and use 100X of the blocking agent.

The 100X Blocking Agent can be prepared in advance and stored at -20°C.

2 Prepare the Hybridization Master Mix by mixing the components in the
tables below according to the microarray format used.

Table 54  Multiplier to calculate the volume of Hybridization Master Mix for 1x
microarrays*

Component Per Total volume needed Additional volume needed in
reaction incolumn1ifN <=32 column2ifN > 32
(nL)
1XTE 131.8 (131.8 uyLx N) + (131.8 uL x (N-32)) + 412.8 pL
412.8 uL
Cot-1 DNA (1.0 mg/mL)T 50 (50 pLx N) +156.6 uyL (50 pL x (N-32)) + 156.6 pL
Agilent 100X Blocking 5.2 (5.2puLxN)+16.3puL (5.2 uLx (N-32)) +16.3 L
Agent1
Agilent 2X Hi-RPM 260 (260 pLx N) +814.3 uL (260 pL x (N-32)) + 814.3 pL

Hybridization Buffer'

Final Volume of 447 (447 pL x N) + 1400 pL (447 pL x (N-32)) + 1400 pL
Hybridization Master Mix

*

N is the number of experimental samples (8, 16, 24, 32, 40 or 48). Do not count reference samples.
t Use Cot-1 DNA from the appropriate species.
1 Supplied with Agilent Oligo aCGH Hybridization Kit
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Table 55  Multiplier to calculate the volume of Hybridization Master Mix for 2x
microarrays
Component Per reaction (pL) Total volume needed
1XTE 29.4 (29.4 pL x N) + 220.1 pL
Cot-1 DNA (1.0 mg/mL)* 25 (25 uLx N) +187.2 pL
Agilent 100X Blocking Agentt 2.6 (2.6 pLx N) +19.5uL
Agilent 2X Hi-RPM Hybridization Buffer' 130 (130 pLx N) +973.3 uL
Final Volume of Hybridization Master Mix 187 (187 pL x N) + 1400 pL
* Use Cot-1 DNA from the appropriate species.
t Supplied with Agilent Oligo aCGH Hybridization Kit
Table 56  Multiplier to calculate the volume of Hybridization Master Mix for 4x
microarrays
Component Per reaction (uL) Total volume needed
Cot-1 DNA (1.0 mg/mL)’ 5 (5L x N) + 114.6 pL
Agilent 100X Blocking AgentT 1.1 (1.1 uLx N) +25.2 L
Agilent 2X Hi-RPM Hybridization Buffer’ 55 (55 pL x N) +1260.2 pL
Final Volume of Hybridization Master Mix  61.1 (61.1 pL x N) + 1400 pL
* Use Cot-1 DNA from the appropriate species.
t Supplied with Agilent Oligo aCGH Hybridization Kit
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Table 57 Multiplier to calculate the volume of Hybridization Master Mix for 8x
microarrays

Component Per reaction (pL) Total volume needed
1IXTE 4.05 (4.05 pLx N) +195.5 uL
Cot-1 DNA (1.0 mg/mL)* 2 (2L x N) +96.6 pL
Agilent 100X Blocking AgentT 0.45 (0.45 uLx N) + 21.7 pL
Agilent 2X Hi-RPM Hybridization Buffer’ 225 (22.5 uLx N) + 1086.2 pL
Final Volume of Hybridization Master Mix 29 (29 pL x N) + 1400 pL

*

Use Cot-1 DNA from the appropriate species.

t Supplied with Agilent Oligo aCGH Hybridization Kit

3 Add hybridization mix to the reservoir in location 4. Be careful not to
generate bubbles.

For 1x and £ 32 samples, 2x, 4x and 8x: add to column 1.
For 1x and > 32 samples: add to column 1 and 2.
4 Start the CGH+SNP_HybridizationPrepProtocol_Enz protocol run.

For 1x and 2x microarrays, the Bravo platform transfers the hybridization
master mix to the empty deep-well or tall-chimney plates. Continue at
step 5.

For 4x and 8x microarrays, the Bravo platform combines the Cy5 and Cy3
labeled, purified samples and adds the hybridization master mix. Continue
at step 6.

5 For 1x and 2x microarrays:

a When the Bravo platform pauses at the Protocol User Message task, put
the working plate that contains the labeled, purified DNA at location 8.

b Click Continue in the VWorks software.

The Bravo platform adds the Cy3 and Cyb labeled, purified gDNA to the
hybridization master mix.
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When the number of samples is greater than 40, the Bravo platform runs out of tips before
the end of the protocol run.

If you see the error message Error in automatic tip operation, put more tips into the Bravo
platform. Go to Tools > Tip State Editor, and update the status of the tip boxes.

6 When the protocol run is finished, remove, seal, spin, and transfer the
deep-well plate from location 7, tall-chimney from location 5, or the PCR
plate from location 8 to a thermocycler. Program the thermocycler
according to Table 58 and run the program.

For the 1x microarray deep-well plates, use an incubator that is compatible
with deep-well plates, such as the Eppendorf ThermoStat plus (Eppendorf
p/n 022670204 with deep-well plate block p/n 022670565).

Table 58 DNA preparation before hybridization

Step Temperature Time
Step 1 95°C 3 minutes
Step 2 37°C 30 minutes

7 Spin the plate in a centrifuge for 30 seconds at 6,000 x g to drive the
contents off the walls and lid.

The samples are ready for the Hybridization step.
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Agilent Oligonucleotide Array-Based CGH for Genomic DNA Analysis
Protocol

5
Microarray Processing and Feature
Extraction

Step 1. Microarray Hybridization 96
Step 2. Wash Preparation 98
Step 3. Microarray Washing 102

Step 4. Microarray Scanning using Agilent C, B or A Scanner or GenePix
Scanner 108

Step 5. Data Extraction using Feature Extraction Software 111

Microarray processing consists of hybridization, washing, and scanning.

Feature Extraction is the process by which data is extracted from the scanned
microarray image (.tif) and translated into log ratios, allowing researchers to

measure DNA copy number changes in their experiments in conjunction with
Agilent Genomic Workbench Software.

Agilent Technologies
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Step 1. Microarray Hybridization

Familiarize yourself with the assembly and disassembly instructions for use with the
Agilent microarray hybridization chamber and gasket slides. Please refer to the Agilent
Microarray Hybridization Chamber User Guide (G2534-90001) for in-depth instructions on
how to load samples, assemble and disassemble chambers, as well as other helpful tips.
This user guide can be downloaded from the Agilent Web site at
www.agilent.com/chem/dnamanuals-protocols.

Microarray Handling Tips

Each microarray is printed on the side of the glass slide containing the
“Agilent”-labeled barcode. This side is called the “active side”. The numeric
barcode is on the “inactive side” of the glass slide.

The hybridization sample mixture is applied directly to the gasket slide and
not to the microarray slide. Then the active side of the microarray slide is put
on top of the gasket slide to form a “sandwich slide pair”.

To avoid damaging the microarray, always handle glass slides carefully by
their edges. Wear powder-free gloves. Never touch the surfaces of the slides. If
you do, you may cause irreparable damage to the microarray.

Never allow the microarray surface to dry out during the hybridization
process and washing steps.

Hybridization Assembly

1 Load a clean gasket slide into the Agilent SureHyb chamber base with the
gasket label facing up and aligned with the rectangular section of the
chamber base. Ensure that the gasket slide is flush with the chamber base
and is not ajar.

2 Slowly dispense 490 uL (for 1x microarray), 245 uL (for 2x microarray), 100
uL (for 4x microarray) or 40 uL (for 8x microarray) of hybridization sample
mixture onto the gasket well in a “drag and dispense” manner. For
multi-pack microarray formats (i.e. 2x, 4x or 8x microarray), load all gasket
wells before you load the microarray slide. For multi-pack formats, refer to
“Agilent Microarray Layout and Orientation” on page 131
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Keep the temperature of hybridization sample mixtures as close to 37°C as possible. To
do this, process them in small batches and/or put them on a heat block, thermocycler
orin an oven.

3 Put a microarray slide “active side” down onto the gasket slide, so the
numeric barcode side is facing up and the “Agilent”-labeled barcode is
facing down. Assess that the sandwich-pair is properly aligned.

4 Put the SureHyb chamber cover onto the sandwiched slides and slide the
clamp assembly onto both pieces.

5 Hand-tighten the clamp firmly onto the chamber.

6 Vertically rotate the assembled chamber to wet the slides and assess the
mobility of the bubbles. Tap the assembly on a hard surface if necessary to
move stationary bubbles.

7 Put assembled slide chamber in the rotator rack in a hybridization oven set
to 65°C. Set your hybridization rotator to rotate at 20 rpm.

8 Hybridize at 65°C:
24 hours for blood, cell and tissue samples (4x and 8x microarrays)
40 hours for blood, cell and tissue samples (1x and 2x microarrays)

40 hours for FFPE samples (1x, 2x, 4x and 8x microarrays)

If you are not loading all the available positions on the hybridization rotator rack, be
sure to balance the loaded hybridization chambers on the rack similar to a centrifuge to
prevent unnecessary strain on the oven motor.

For more information on the effects of hybridization temperature and time, as
well as the rotation speed on the final microarray results, please refer to the
application note titled “60-mer Oligo-Based Comparative Genomic
Hybridization” (publication 5989-4848EN) from the Agilent Web site at
www.agilent.com/chem/dnaapplications.
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Step 2. Wash Preparation

Cyanine 5 has been shown to be sensitive to ozone degradation. Ozone levels as low as 5
ppb (approximately 10 pg/m?) can affect Cyanine 5 signal and compromise microarray
results. The Agilent Stabilization and Drying Solution and the Ozone-Barrier Slide Cover are
designed to protect against ozone-induced degradation of Cyanine dyes. Note that the
Ozone-Barrier Slide covers are compatible with the slide holders of the Agilent B and C
model scanners only.

Another option to address ozone-induced Cyanine-5 degradation is to use Carbon Loaded
Non-woven Filters to remove ozone from the air. These filters can be installed in either your
HVAC system, or as part of small Ozone Controlled Enclosures. These free-standing
enclosures can be installed either on a lab bench or as a walk-in room within your lab.
These products are available through filter suppliers listed in Agilent Technical Note
5989-0875EN.

Before you begin, determine which wash procedure to use:

Table 59 Wash procedure to follow

Ozone level in Wash Procedure Ozone-Barrier
your lab Slide Cover
<5ppb “Wash Procedure A (without Stabilization and Drying No

Solution)” on page 102

>5ppb <10 ppb “Wash Procedure A (without Stabilization and Drying Yes
Solution)” on page 102

> 10 ppb “Wash Procedure B (with Stabilization and Drying Yes
Solution)” on page 105

Equipment Preparation

Do not use detergent to wash the staining dishes as some detergents may leave
fluorescent residue on the dishes. If you do, you must ensure that all traces are
removed by thoroughly rinsing with Milli-Q water.

Always use clean equipment when conducting the wash procedures.
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Use only dishes that are designated and dedicated for use in Agilent oligo
aCGH experiments.

Cleaning with Milli-Q Water Wash
Rinse slide-staining dishes, slide racks and stir bars thoroughly with
high-quality Milli-Q water before use and in between washing groups.

a Run copious amounts of Milli-Q water through the slide-staining dishes,
slide racks and stir bars.

b Empty out the water collected in the dishes at least five times.

¢ Repeat step a and step b until all traces of contaminating material are
removed.

Cleaning with Acetonitrile Wash (Wash Procedure B Only)

Acetonitrile wash removes any remaining residue of Agilent Stabilization
and Drying Solution from slide-staining dishes, slide racks and stir bars
that were used in previous experiments with “Wash Procedure B (with
Stabilization and Drying Solution)” on page 105.

m Do acetonitrile washes in a vented fume hood. Acetonitrile is highly flammable and
toxic.

a Add the slide rack and stir bar to the slide-staining dish, and transfer to
a magnetic stir plate.

b Fill the slide-staining dish with 100% acetonitrile.

¢ Turn on the magnetic stir plate and adjust the speed to a setting of 4
(medium speed).

d Wash for 5 minutes at room temperature.

e Discard the acetonitrile as is appropriate for your site.

—r

Repeat step a through step e.
Air dry everything in the vented fume hood.

= @«

Continue with the Milli-Q water wash as previously instructed.
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Prewarming Oligo aCGH Wash Buffer 2 (Overnight)

The temperature of Oligo aCGH Wash Buffer 2 must be at 37°C for optimal
performance.

1 Add the volume of buffer required to a disposable plastic bottle and warm
overnight in an incubator or circulating water bath set to 37°C.

2 Put a slide-staining dish into a 1.5 L glass dish three-fourths filled with
milli-Q water and warm to 37°C by storing overnight in an incubator set to
37°C.

Prewarming Stabilization and Drying Solution (Wash Procedure B Only)

The Agilent Stabilization and Drying Solution contains an ozone scavenging
compound dissolved in acetonitrile. The compound in solution is present in
saturating amounts and may precipitate from the solution under normal
storage conditions. If the solution shows visible precipitation, warming of the
solution will be necessary to redissolve the compound. Washing slides using
Stabilization and Drying Solution showing visible precipitation will have
profound adverse affects on array performance.

The Agilent Stabilization and Drying Solution is a flammable liquid. Warming the
solution will increase the generation of ignitable vapors. Use gloves and eye/face
protection in every step of the warming procedures.

Do not use a hot plate, oven, an open flame or a microwave. Do not increase
temperature rapidly. Warm and mix the material away from ignition sources.

Failure to follow the outlined process will increase the potential for fire, explosion,
and possible personal injury.

100

1 Put a clean magnetic stir bar into the Stabilization and Drying Solution
bottle and recap.

2 Partially fill a plastic bucket with hot water at approximately 40°C to 45°C
(for example from a hot water tap).

3 Put the Stabilization and Drying Solution bottle into the hot water in the
plastic bucket.
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4 Put the plastic bucket on a magnetic stirrer (not a hot-plate) and stir.

5 The hot water cools to room temperature. If the precipitate has not all
dissolved replenish the cold water with hot water.

6 Repeat step 5 until the solution is clear.

71 After the precipitate is completely dissolved, allow the solution to
equilibrate to room temperature prior to use.

Do not filter the Stabilization and Drying solution, or the concentration of the ozone
scavenger may vary.
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Step 3. Microarray Washing

Before you begin, determine which wash procedure to use:

Table 60 \Wash procedure to follow

Ozone level in Wash Procedure Ozone-Barrier
your lab Slide Cover
<5 ppb “Wash Procedure A (without Stabilization and Drying No

Solution)” on page 102
>5ppb <10 ppb “Wash Procedure A (without Stabilization and Drying Yes

Solution)” on page 102
> 10 ppb “Wash Procedure B (with Stabilization and Drying Yes

Solution)” on page 105

Wash Procedure A (without Stabilization and Drying Solution)

Always use fresh Oligo aCGH Wash Buffer 1 and Oligo aCGH Wash Buffer 2 for

each wash group (up to five slides).

Table 61 lists the wash conditions for the Wash Procedure A without

Stabilization and Drying Solution.

Table 61 Wash conditions

Dish  Wash buffer Temperature Time
Disassembly  #1 Oligo aCGH Wash Buffer 1 Room temperature
1st wash #H2 Oligo aCGH Wash Buffer 1 Room temperature 5 minutes
2nd wash #3 Oligo aCGH Wash Buffer2  37°C 1 minute

1 Completely fill slide-staining dish #1 with Oligo aCGH Wash Buffer 1 at

room temperature.

2 Put a slide rack into slide-staining dish #2. Add a magnetic stir bar. Fill
slide-staining dish #2 with enough Oligo aCGH Wash Buffer 1 at room
temperature to cover the slide rack. Put this dish on a magnetic stir plate.

3 Put the prewarmed 1.5 L glass dish filled with water and containing
slide-staining dish #3 on a magnetic stir plate with heating element. Fill the
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slide-staining dish #3 approximately three-fourths full with Oligo aCGH
Wash Buffer 2 (warmed to 37°C). Add a magnetic stir bar. Turn on the
heating element and maintain temperature of Oligo aCGH Wash Buffer 2 at
37°C; monitor using a thermometer.

4 Remove one hybridization chamber from incubator and resume rotation of
the others. Record whether bubbles formed during hybridization and if all
bubbles are rotating freely.

5 Prepare the hybridization chamber disassembly.

a Put the hybridization chamber assembly on a flat surface and loosen the
thumbscrew, turning counter-clockwise.

b Slide off the clamp assembly and remove the chamber cover.

¢ With gloved fingers, remove the array-gasket sandwich from the chamber
base by lifting one end and then grasping in the middle of the long sides.
Keep the microarray slide numeric barcode facing up as you quickly
transfer the sandwich to slide-staining dish #1.

d Without letting go of the slides, submerge the array-gasket sandwich into
slide-staining dish #1 containing Oligo aCGH Wash Buffer 1.

6 With the sandwich completely submerged in Oligo aCGH Wash Buffer 1, pry
the sandwich open from the barcode end only. Do this by slipping one of the
blunt ends of the forceps between the slides and then gently twist the
forceps to separate the slides. Let the gasket slide drop to the bottom of the
staining dish. Remove the microarray slide, grasp it from the upper corners
with thumb and forefinger, and quickly put into slide rack in the
slide-staining dish #2 containing Oligo aCGH Wash Buffer 1 at room
temperature. Minimize exposure of the slide to air. Touch only the barcode
portion of the microarray slide or its edges!

7 Repeat step 4 through step 6 for up to four additional slides in the group. A
maximum of five disassembly procedures yielding five microarray slides is
advised at one time in order to facilitate uniform washing.

8 When all slides in the group are put into the slide rack in slide-staining dish
#2, stir using setting 4 for 5 minutes. Adjust the setting to get good but not
vigorous mixing.

9 Transfer slide rack to slide-staining dish #3 containing Oligo aCGH Wash
Buffer 2 at 37°C, and stir using setting 4 for 1 minute.

10 Slowly remove the slide rack trying to minimize droplets on the slides. It
should take 5 to 10 seconds to remove the slide rack.

11 Discard used Oligo aCGH Wash Buffer 1 and Oligo aCGH Wash Buffer 2.
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12 Repeat step 1 through step 11 for the next group of five slides using fresh
Oligo aCGH Wash Buffer 1 and Oligo aCGH Wash Buffer 2 pre-warmed to
37°C.

13 Put the slides in a slide holder:

In environments in which the ozone level exceeds 5 ppb, immediately put
the slides with Agilent barcode facing up in a slide holder. Make sure that

the slide is not caught up on any corner. Put an ozone-barrier slide cover
on top of the array as shown in Figure 9.

Figure 9 Inserting the ozone-barrier slide cover

In environments in which the ozone level is below 5 ppb, put the slides
with Agilent barcode facing up in a slide holder.

14 Scan slides immediately to minimize impact of environmental oxidants on
signal intensities. If necessary, store slides in the original slide boxes in a
Ny purge box, in the dark.
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Wash Procedure B (with Stabilization and Drying Solution)

Cyb is susceptible to degradation by ozone. Use this wash procedure if the

ozone level exceeds 10 ppb in your laboratory.

Always use fresh Oligo aCGH Wash Buffer 1 and Oligo aCGH Wash Buffer 2 for
each wash group (up to five slides).

The acetonitrile (dish #4) and Stabilization and Drying Solution (dish #5)
below may be reused for washing up to 4 batches of 5 slides (total 20 slides) in
one experiment. Do not pour the Stabilization and Drying Solution back in the

bottle.

m The Stabilization and Drying Solution must be set-up in a fume hood. Put the Wash
Buffer 1 and Wash Buffer 2 set-up areas close to, or preferably in, the same fume
hood. Use gloves and eye/face protection in every step of the washing procedure.

Table 62 lists the wash conditions for the Wash Procedure B with Stabilization

and Drying Solution.

Table 62 Wash conditions

Dish  Wash Buffer Temperature Time
Disassembly #1 Oligo aCGH Wash Buffer 1 Room temperature
1st wash #2 Oligo aCGH Wash Buffer 1 Room temperature 5 minutes
2nd wash #3 Oligo aCGH Wash Buffer2  37°C 1 minute
Acetonitrile wash #4 Acetonitrile Room temperature 10 seconds
3rd wash #b Stabilization and Drying Room temperature 30 seconds

Solution

1 Completely fill slide-staining dish #1 with Oligo aCGH Wash Buffer 1 at

room temperature.

2 Put a slide rack into slide-staining dish #2. Add a magnetic stir bar. Fill
slide-staining dish #2 with enough Oligo aCGH Wash Buffer 1 at room
temperature to cover the slide rack. Put this dish on a magnetic stir plate.

3 Put the prewarmed 1.5 L glass dish filled with water and containing
slide-staining dish #3 on a magnetic stir plate with heating element. Fill the
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slide-staining dish #3 approximately three-fourths full with Oligo aCGH
Wash Buffer 2 (warmed to 37°C). Add a magnetic stir bar. Turn on the
heating element and maintain temperature of Oligo aCGH Wash Buffer 2 at
37°C; monitor using a thermometer.

In the fume hood, fill slide-staining dish #4 approximately three-fourths full
with acetonitrile. Add a magnetic stir bar and put this dish on a magnetic
stir plate.

In the fume hood, fill slide-staining dish #5 approximately three-fourths full
with Stabilization and Drying Solution. Add a magnetic stir bar and put this
dish on a magnetic stir plate.

Remove one hybridization chamber from incubator and resume rotation of
the others. Record whether bubbles formed during hybridization, and if all
bubbles are rotating freely.

Prepare the hybridization chamber disassembly.

a Put the hybridization chamber assembly on a flat surface and loosen the
thumbscrew, turning counter-clockwise.

b Slide off the clamp assembly and remove the chamber cover.

¢ With gloved fingers, remove the array-gasket sandwich from the chamber
base by lifting one end and then grasping in the middle of the long sides.
Keep the microarray slide numeric barcode facing up as you quickly
transfer the sandwich to slide-staining dish #1.

d Without letting go of the slides, submerge the array-gasket sandwich into
slide-staining dish #1 containing Oligo aCGH Wash Buffer 1.

With the sandwich completely submerged in Oligo aCGH Wash Buffer 1, pry
the sandwich open from the barcode end only. Do this by slipping one of the
blunt ends of the forceps between the slides and then gently twist the
forceps to separate the slides. Let the gasket slide drop to the bottom of the
staining dish. Remove the microarray slide, grasp it from the upper corners
with thumb and forefinger, and quickly put into slide rack in the
slide-staining dish #2 containing Oligo aCGH Wash Buffer 1 at room
temperature. Minimize exposure of the slide to air. Touch only the barcode
portion of the microarray slide or its edges!

Repeat step 6 through step 8 for up to four additional slides in the group. A
maximum of five disassembly procedures yielding five microarray slides is
advised at one time in order to facilitate uniform washing.
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10 When all slides in the group are placed into the slide rack in slide-staining
dish #2, stir using setting 4 for 5 minutes. Adjust the setting to get good but
not vigorous mixing.

11 Transfer slide rack to slide-staining dish #3 containing Oligo aCGH Wash
Buffer 2 at 37°C, and stir using setting 4 for 1 minute.

12 Remove the slide rack from Oligo aCGH Wash Buffer 2 and tilt the rack
slightly to minimize wash buffer carry-over. Quickly transfer the slide rack
to slide-staining dish #4 containing acetonitrile, and stir using setting 4 for
10 seconds.

13 Transfer slide rack to slide-staining dish #5 filled with Stabilization and
Drying Solution, and stir using setting 4 for 30 seconds.

14 Slowly remove the slide rack trying to minimize droplets on the slides. It
should take 5 to 10 seconds to remove the slide rack.

15 Discard used Oligo aCGH Wash Buffer 1 and Oligo aCGH Wash Buffer 2.

The acetonitrile and the Stabilization and Drying Solution may be reused for washing of up
to four batches of five slides (that is, total 20 microarray slides) in one experiment. Pour the
Stabilization and Drying Solution to a different marked bottle, and protect from light with
other flammables. After each use, rinse the slide rack and the slide-staining dish that were
in contact with the Stabilization and Drying Solution with acetonitrile followed by a rinse in
Milli-Q water.

16 Repeat step 1 through step 15 for the next group of five slides using fresh
Oligo aCGH Wash Buffer 1 and Oligo aCGH Wash Buffer 2 prewarmed to
37°C.

17 Immediately put the slides with Agilent barcode facing up in a slide holder
with an ozone-barrier slide cover on top of the array as shown in Figure 9
on page 104.

18 Scan slides immediately to minimize impact of environmental oxidants on
signal intensities. If necessary, store slides in original slide boxes in a Ny
purge box, in the dark.

19 Dispose of acetonitrile and Stabilization and Drying Solution as flammable
solvents.
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Step 4. Microarray Scanning using Agilent C, B or A Scanner
or GenePix Scanner

Agilent C Scanner Settings

An Agilent C-scanner and Agilent Scanner Control software v8.3 or higher is
required for 1x1M, 2x400K, 4x180K and 8x60K density microarrays and is
optional for 1x244K, 2x105K, 4x44K and 8x15K density microarrays.

1

Put assembled slide holders with or without the ozone-barrier slide cover
into scanner carousel.

Select Start Slot m End Slot n where the letter m represents the Start slot
where the first slide is located and the letter n represents the End slot
where the last slide is located.

Select Profile Agilent G3_CGH for 1x1M, 2x400K, 4x180K and 8x60K
microarrays. Select Profile Agilent HD_CGH for 1x244K, 2x105K, 4x44K
and 8x15K microarrays.

Verify that
Slide ID is set to <Auto Detect>.
Channels is set to R+G
Scan region is set to Agilent HD (61 x 21.6 mm).

Resolution (um) is set to 3 uym for 1x1M, 2x400K, 4x180K and 8x60K
microarrays, and 5 um for 1x244K, 2x105K, 4x44K and 8x15K
microarrays.

Tiff is set to 16 bit

R PMT is set to 100%.

G PMT is set to 100%.

XDR is set to <No XDR>.

Output Path Browse is set for desired location.

Verify that the Scanner status in the main window says Scanner Ready.

6 Click Scan Slot m-n on the Scan Control main window where the letter m

represents the Start slot where the first slide is located and the letter n
represents the End slot where the last slide is located.
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Agilent A and B Scanner Settings

Agilent Scanner Control software v7.0.03 is recommended for 5 uym scans of
1x, 2%, 4x and 8x density microarrays.

1 Assemble slides into appropriate slide holders:

For version B and A slide holders, put slide into slide holder, with or
without the ozone-barrier slide cover, with Agilent barcode facing up.

For version A slide holders, check that slides are seated parallel to the
bottom of the slide holder.

2 Put assembled slide holders into scanner carousel.
3 Verify Default Scan Settings (click Settings > Modify Default Settings).
Scan region is set to Scan Area (61 x 21.6 mm).

Scan resolution (um) is set to 5 for 1x244K, 2x105K, 4x44K and 8x15K
microarrays.

Dye channel is set to Red & Green.
Green PMT is set to 100%.
Red PMT is set to 100%.
4 Select settings for the automatic file naming.
Prefixl1 is set to Instrument Serial Number.
Prefix2 is set to Array Barcode.
5 Clear the eXtended Dynamic Range check box.
6 Verify that the Scanner status in the main window says Scanner Ready.

71 Click Scan Slot m-n on the Scan Control main window where the letter m
represents the Start slot where the first slide is located and the letter n
represents the End slot where the last slide is located.
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GenePix Scanner Settings

Agilent 1x244K, 2x105K, 4x44K and 8x15K CGH microarrays require 5 um
scan resolution, which is only supported in the GenePix 4000B scanner.

Agilent 1x1M, 2x400K, 4x180K and 8x60K CGH microarrays require 3 um scan
resolution, which is not supported in the GenePix 4000B scanner.
¢ Refer to the manufacturer's user guide for appropriate scanner settings.

¢ Refer to “Agilent Microarray Layout and Orientation” on page 131 for
appropriate slide layout and orientation in GenePix scanner.
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Step 5. Data Extraction using Feature Extraction Software

The Feature Extraction software v10.10 or higher supports extraction of
microarray TIFF images (.tif) of Agilent CGH+SNP microarrays scanned on the
Agilent C Scanner.

The Feature Extraction software v10.5 or higher supports extraction of
microarray TIFF images (.tif) of Agilent CGH microarrays scanned on the
Agilent C Scanner but does not support extraction of Agilent CGH microarrays
on the GenePix 4000B scanner.

The Feature Extraction software v9.5 supports extraction of microarray TIFF
images (.tif) of Agilent CGH microarrays scanned on the Agilent B Scanner
and GenePix 4000B Scanner.

Feature Extraction version 10.7 or higher can automatically download Grid
Templates, protocols and QC metrics (QCMT) from eArray if configured
appropriately. See “Automatic Download from eArray” on page 115 for
configuration.

Figure 10 shows an example of an Agilent SurePrint G3 1x1M CGH microarray
image opened in Feature Extraction software v10.5 in both full and zoomed
view.
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Step 5. Data Extraction using Feature Extraction Software

Figure 10  Agilent SurePrint G3 1x1M CGH microarray shown in red and green channels:
full and zoomed view

1 Open the Agilent Feature Extraction program.
2 Add the images (.tif) to be extracted to the Feature Extraction Project.

a Click Add New Extraction Set(s) icon on the toolbar or right-click the
Project Explorer and select Add Extraction...

You can also drag the image (.tif) from the desktop to the Feature
Extraction project pane.

b Browse to the location of the .tif files, select the .tif file(s) and click
Open. To select multiple files, use the Shift or Ctrl key when selecting.

The Feature Extraction program automatically assigns a default grid
template and protocol for each extraction set, if the following conditions
are met:

° As of v10.5, the Feature Extraction program automatically associates the
protocol for a given array based on the application specified in the
design file and the number of channels present in the image. If you need
to use a protocol other than the Agilent default protocol, specify it in the
Grid Template properties.

* For auto assignment of the CGH Feature Extraction protocol, the default
CGH protocol must be specified in the Feature Extraction Grid Template
properties.
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To access the Feature Extraction Grid Template properties, double-click
on the grid template in the Grid Template Browser.

3 Set Feature Extraction Project Properties.
a Select the Project Properties tab.
b In the General section, enter your name in the Operator field.

¢ In all other sections, verify that at least the following default settings as
shown in Figure 11 below are selected.

d For Feature Extraction 9.5, in the Other section, select
CGH_QCMT_Feb08.

For Feature Extraction 10.5 or higher, the metric sets are part of the
protocol, and there is no need to set them.

QC metrics updates are available automatically from eArray if
configured appropriately. See “Automatic Download from eArray” on
page 115 for configuration.

ﬁ Project Properties |ﬂ Extraction Set Configuration |

=]
Operator Unknawn
=]
Mumber of Extraction Sets Included ]
= "
'B Outputs
MAGE Mone
JPEG Mone
B TExT Local File anly
Qukput Package Compact
Wisual Results Local File anly
5rid Mone
QU Report Local PDF File anly
FTP Send Tiff File Falze
{3 Local File Folder

Same As Irmage True

\[H FTP Setting

| Highest Priority Defaulk Protocol Grid Template Defaulk
Praoject Default Protocol
|l Automs -
=g Grid File if available Falze
External DyeMarm List File
Owerwrite Previous Resulks Falze

Figure 11  Default settings in Feature Extraction 10.5
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4 Check the Extraction Set Configuration.
a Select the Extraction Set Configuration tab.

b Verify that the correct grid template is assigned to each extraction set in
the Grid Name column. To assign a different grid template to an
extraction set, select one from the pull down menu.

If a grid template is not available to select from the pull down menu, you
must add it to the Grid Template Browser. To add, right-click inside the
Grid Template Browser, select Add. Look for the design file (.xml) and
click Open to load grid template into the Feature Extraction database.

To update to the latest grid templates via Online Update, right-click Grid
Template Browser and select Online Update. You can also download the
latest grid templates from Agilent Web site at
www.agilent.com/chem/downloaddesignfiles. After downloading, you
must add the grid templates to the Grid Template Browser.

As of v10.5, the Feature Extraction program automatically associates the
protocol for a given array based on the application specified in the
design file and the number of channels present in the image. If you need
to use a protocol other than the Agilent default protocol, specify it in the
Grid Template properties.

¢ Verify that the most recent protocol is assigned to each extraction set in
the Protocol Name column.

If a protocol is not available to select from the pull down menu, you must
import it to the Feature Extraction Protocol Browser. To import,
right-click the Feature Extraction Protocol Browser, select Import.
Browse for the Feature Extraction protocol (.xml) and click Open to load
the protocol into the Feature Extraction database. Visit Agilent Web site
at www.agilent.com/chem/feprotocols to download the latest protocols.

Protocols are also available automatically from eArray if configured
appropriately. See “Automatic Download from eArray” on page 115 for
configuration.

b5 Save the Feature Extraction Project (.fep) by selecting File > Save As and
browse for desired location.

6 Verify that the icons for the image files in the Feature Extraction Project
Window no longer have a red X through them. A red X through the icon
indicates that an extraction protocol was not selected or that the Grid
Template is not in the database. If needed, reselect the extraction protocol
for that image file.
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Select Project > Start Extracting.

8 After the extraction is completed successfully, view the QC report for each
extraction set by double-clicking the QC Report link in the Summary
Report tab. Determine whether the grid has been properly placed by
inspecting Spot Finding of the Four Corners of the Array. See Figure 13.

Automatic Download from eArray

Feature Extraction version 10.7 or higher can automatically download Grid
Templates, protocols and QC metrics (QCM or QCMT). To set this up, in the
eArray Login Setting dialog box, under Advanced Options, click Use eArray
server during extraction. See Figure 12.

eArray Login Setting @

eAmray Login Setting (earray.chem. aglent.com)

d | Test Connection

For an eArray account please register first Register

Advanced Options
¥ Use eduray server during extraction

[~ Check for updates of grid template
B
™ ©On starting FE check for protocol update from efray server

I~ Dont show this dialog again [ ] cose |

Figure 12 eArray Login Setting. You can mark the other two check boxes under Ad-
vanced Options if you want to get update of grid templates already in the data-
base or to get protocol updates. See the Feature Extraction user guide for
more information.
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Microarray QC Metrics

These metrics are only appropriate for samples analyzed with Agilent CGH
microarrays by following the standard operational procedures provided in this
user guide. These metrics are exported to a table in the Feature Extraction QC
report (in Feature Extraction 9.5, select CGH_QCMT_Feb08 in Project
Properties before extraction) and in Genomic Workbench. They can be used to
assess the relative data quality from a set of microarrays in an experiment. In
some cases, they can indicate potential processing errors that have occurred
or suggest that the data from particular microarrays might be compromised.
Many factors can influence the range of these metrics, including the
microarray format (1x, 2x, 4x or 8x), biological sample source, quality of
starting gDNA, experimental processing, scanner sensitivity, and image
processing. The value guidelines presented below represent the thresholds
that Agilent has observed when analyzing samples using this protocol.

To achieve a high SNP call rate and accuracy when processing SurePrint G3
CGH+SNP microarrays, make sure the DLRSpread is <0.2.

Table 63 QC metric thresholds for ULS labeling

Blood and Cell Tissue Samples FFPE Samples
Samples
BGNoise <15 <15 <15
Signal Intensity  >90 >90 >90
Signal to Noise ~ >20 >20 >10
Reproducibility ~ <0.2 <0.2 <0.2
DLRSpread <0.2 <0.3 <0.4
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Table 64 QC metric thresholds for Enzymatic labeling

Metric Excellent Good Poor
BGNoise <b 5to0 10 >10
Signal Intensity > 150 50 to 150 <50
Signal to Noise >100 30to 100 <30
Reproducibility <0.05 0.05t0 0.2 >0.2
DLRSpread <0.2 0.2t0 0.3 >0.3
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QC Report - Agilent Technologies : 2 Color CGH

Date Friday, November 07, 2008 - 20:03 Sample(red/green)

User Name krishnakant_lowanshi  FE Version 10.5.0.13
Image US22502705_251328222285_S01 BG Method Detrend on (NegC)
Protocol CGH_105_Nov08 (Read Only) Multiplicative Detrend True
Grid 013282_D_20050613 Dye Norm Linear

CGH_QCMT_Nov08 : (10 of 10) QCMetrics InRange

Metric Name Value UpLim LowLim
AnyColorPrcntFeatNonUnifOL 0.04 1.00 NA
DerivativeLR_Spread 0.21 0.30 NA
gRepro 0.04 0.20 NA
g_BGNoise 2.78 15.00 NA
g_Signal2Noise 76.22 NA  30.00
g_Signallntensity 212.21 NA  50.00
rRepro 0.04 0.20 NA
Grid Normal r_BGNoise 4.25 15.00 NA
- - - P N I12Noi: 71.37 NA d
Outlier Numbers with Spatial Distribution E=Signa olsg 3 30500
206 rows x 215 columns r_Signallntensity 303.34 NA 50.00
= L -
* . Histogram of Signals Plot (Red)
- . -
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Figure 13  CGH QC report generated from Feature Extraction software v10.5, page 1
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Red and Green Background Corrected Signals (Non-

Control Inliers)
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Figure 14  CGH QC report generated from Feature Extraction software v10.5, page 2
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This chapter contains potential causes for above-threshold DLRSD (Derivative
Log Ratio Standard Deviation). A poor DLRSD score reflects high
probe-to-probe log ratio noise.

For troubleshooting information for the Bravo platform, refer to the Brawvo
Platform User Guide (G5409-90004) and the VWorks Software User Guide

(G5415-90002).
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If you have a low 0D260/230 or 0D260/280 value

A low OD260/230 value can indicate contaminants, such as residual salt or
organic solvents (which would inhibit enzyme). A low OD260/280 value
indicates residual protein. Either condition can result in low specific activity
(pmol dye/ug DNA) or Degree of Labeling. See “To determine yield, degree of
labeling or specific activity” on page 55, page 69 or page 87.

v’ Repurify the DNA using the Qiagen DNeasy protocol. See “DNA
Isolation” on page 23. This procedure includes a proteinase K treatment.

v/ If you must do a phenol/chloroform DNA extraction, do not get too
close to the interface.

Phenol has an absorbance maximum of 270-275 nm, which is close to that
of DNA. Phenol contamination mimics both higher purity and higher yields,
because of an upward shift in the OD260 value.

v/ Make sure to calibrate the spectrophotometer with the appropriate buffer.

v’ The ULS labeling is very sensitive to salt contamination. Use 80% EtOH
instead of AW2 in the DNA extraction step and elute in water.

v/ The ULS Labeling will label proteins that compete for dye. Make sure that
the DNA is free of proteins. See “DNA Isolation” on page 23.

If you have poor sample quality due to residual RNA

The input amount of DNA for the experimental labeling reaction must be

the same as for the reference sample labeling reaction. RNA absorbs at the
same wavelength as DNA, which in an RNA-contaminated sample results in a
DNA overestimation.

v Repurify the DNA using the Qiagen DNeasy protocol. See “DNA
Isolation” on page 23. This procedure includes a RNase A treatment.

v/ The ULS labeling will label RNA that will hybridize to the array.
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If you get poor sample quality due to degradation

For non-FFPE samples: On a 1 to 1.5% agarose gel, intact genomic DNA
should appear as a compact, high-molecular weight band with no lower
molecular weight smears. Degraded DNA results in biased labeling.

v/ Check DNA on a 1 to 1.5% agarose gel. If DNA that was isolated from cells,
blood or frozen tissue is degraded, then repurify the DNA using the Qiagen
DNeasy protocol. See “DNA Isolation” on page 23.

v/ Make sure that the DNA is not over-fragmented prior to labeling. Possible
causes are incorrect temperature or length of incubation at 95°C, or
evaporation (use a thermocycler with heated lid). Make sure most of the
heat fragmented products are between 1000 and 3000 bases in length.
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If the estimated concentration is too high or low

The input amount of DNA for the experimental labeling reaction must be the
same as for the reference sample labeling reaction. Precipitated DNA or DNA
that is at a very high concentration cannot be quantitated accurately.

Contaminants such as organic solvents and RNA also absorb at 260 nm, which
results in an inaccurate DNA quantitation.

v/ Make sure that the gDNA is completely in solution by pipetting up and
down. If needed, incubate at 37°C for 30 minutes. If the gDNA
concentration is > 350 ng/uL, dilute 1:2 in water and re-quantitate to make
sure quantitation is accurate.

v Different DNA isolation methods can create different quantitation artifacts,
the risk of assay noise is higher when the experimental and reference DNA
samples are isolated from different sources. Verify the DNA concentration
with an independent method. If you used a spectrophotometer (e.g.
Nanodrop) for the initial measurement, also use a fluorometer (e.g. Qubit)
to verify.

v If needed, repurify the DNA using the Qiagen DNeasy protocol. See “DNA
Isolation” on page 23.
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If you have low specific activity or degree of labeling not due
to poor sample quality

Low specific activity or degree of labeling can result from sub-optimal labeling
conditions such as Cyanine dUTP with too many freeze thaws, enzyme
degradation due to being left warm for too long, wrong temperatures or times,
volume mistakes, or too much exposure to light or air.

v’ Store Cyanine dUTP at 4°C. Keep enzymes on ice and return to -20°C as
quickly as possible.

v’ Double check incubation times and temperatures (use a calibrated
thermometer), and use a thermocycler with heated lid.

v/ Evaporation can be a problem when you process samples in 96-well plates.
Use a plate heat sealer (Eppendorf p/n 951023078) to avoid evaporation.

v Make sure that the pipettors are not out of calibration.

v Make sure that the gDNA, reagents, and master mixes are well mixed. Tap
the tube with your finger or use a pipette to move the entire volume up and
down. Then spin in a microcentrifuge for 5 to 10 seconds to drive the
contents off the walls and lid. Do not mix the stock solutions and reactions
that contain gDNA or enzymes on a vortex mixer.

If you have low yield not due to poor sample quality

Possible sample loss during clean-up after labeling.

v See “Step 2. Purification after ULS labeling” on page 53 or “Step 2.
Purification after Enzymatic labeling” on page 67 or page 84 to remove
unreacted dye. Many other columns result in the loss of shorter fragments.
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If you have post-labeling signal loss

Signal loss can be due to wash or hyb conditions that are too stringent, or
degradation of the Cyanine 5 signal.

Cyanine 5 signal degradation can be caused by ozone or NOx compounds
coming from pollution and/or compressors and centrifuges. Cyanine 5 signal
degradation can result in less red signal around the edges of the features, a
visible gradient of significant Cy5/Cy3 positive ratios and more significant
Cyb/Cy3 negative ratios — especially on the left side of the slide and on slides
scanned later in a batch.

v/ Check oven and Wash 2 temperature.
v/ Check that Wash 2 was not accidentally used instead of Wash 1.

v Wash and scan slides in an ozone controlled environment (<5 ppb), such as
an ozone tent.

v/ Use small batches that can be washed and scanned in about 40 minutes to
minimize exposure to air.

v’ Use the Agilent Ozone-Barrier Slide Cover (p/n G2505-60550).

v’ Use the Stabilization and Drying Solution as described in “Wash Procedure
B (with Stabilization and Drying Solution)” on page 105.
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If you have high BGNoise values

High BGNoise can cause lower signal-to-noise values (see Table 63 or Table 64
on page 117 for thresholds) and higher DLRSD values. BGNoise is defined as
the standard deviation of the signals on the negative controls. If the BGNoise
is high, examine the array image for visible non-uniformities. High BGNoise is
often introduced during the washes.

v/ Make sure that wash dishes, racks and stir bars are clean. Do not use tap
water or detergents to clean wash equipment. If needed, rinse wash
equipment with acetonitrile followed by rinses with MilliQ water.

v’ If needed, wash the slides with acetonitrile:

1 In the fume hood, fill a slide-staining dish approximately three- fourths
full with acetonitrile.

2 Add a magnetic stir bar and put this dish on a magnetic stir plate.

3 Put the slides in a slide rack and transfer the slide rack to the
slide-staining dish containing acetonitrile, and stir using setting 4 for 1
minute.

4 Slowly remove the slide rack and scan the slides immediately.

If you have poor reproducibility

Poor reproducibility (see Table 63 or Table 64 on page 117 for thresholds),
defined as high CVs of signals of replicated probes may indicate that the
hybridization volume was too low or that the oven stopped rotating during the
hybridization. Only very high scores on this metric will affect the DLRSD.

v/ When setting up the gasket-slide hybridization sandwich dispense the
hybridization sample mixture slowly in a “drag and dispense” manner to
prevent spills.

¢/ Check that the oven is rotating.
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If you have poor reproducibility

128 Array-Based CGH for Genomic DNA Analysis - Bravo Automated Liquid Handling Platform



Agilent Oligonucleotide Array-Based CGH for Genomic DNA Analysis
o Protocol

o0 @ @0 ]
0q0 Reference

Supporting User Guides 130

° Agilent Microarray Layout and Orientation 131
Array/Sample tracking on a 8-pack array slide 134
Agilent Information Assets Access Agreement 135

This chapter contains reference information that pertains to this protocol.

~ii Agilent Technologies 129



7 Reference

Supporting User Guides

If you are a first-time user of Agilent’s oligo microarray system, please
refer to the following user guides for detailed descriptions and operation
recommendations for each of the hardware and software components used
in the Oligo aCGH application workflow.

The user guides can be downloaded from the Agilent Web site at
www.agilent.com/chem/dnamanuals-protocols.

e Agilent Microarray Hybridization Chamber User Guide (p/n
G2534-90001)

¢ Agilent Ozone-Barrier Slide Cover User Guide (p/n G2505-90050)

¢ Agilent Technical Note “Improving microarray results by preventing
ozone-mediated fluorescent signal degradation” (p/n 5989-0875EN)

e Agilent G2545A Hybridization Oven User Manual (p/n G2545-80001)

¢ Agilent G2565A A and G2565BA Microarray Scanner System User
Manual

* Agilent G2565CA Microarray Scanner System User Manual

¢ Agilent Microarray Format Technical Drawings with Tolerances (p/n
G4502-90001)

¢ Agilent Feature Extraction Software Quick Start Guide

* Agilent Feature Extraction Software User Guide

¢ Agilent Feature Extraction Software Reference Guide

¢ Bravo Automated Liquid Handling Platform User Guide (p/n G5409-90004)
¢ VWorks Automation Control Setup Guide (p/n G5415-90003)

¢ VWorks Automation Control User Guide (p/n G5415-90002)

¢ VWorks Software Quick Start (p/n G5415-90004)
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Agilent Microarray Layout and Orientation

Agilent oligo microarray (1 microarray/slide format) as imaged on the Agilent
microarray scanner (G2565CA)

Microarrays are printed on the side of the glass with the “Agilent”-labeled barcode
(also referenced as "active side" or "front side").

68291100
TN I

% :

Agilent Microarray
Scanner scans
through the glass.
(Back side scanning.)

Agilent microarray slide holder

Figure 15  Agilent microarray slide and slide holder

Agilent oligo microarray formats and the resulting “microarray design
files” are based on how the Agilent microarray scanner images

1-inch x 3-inch glass slides. Agilent designed its microarray scanner to
scan through the glass slide (back side scanning). The glass slide is
securely placed in an Agilent microarray slide holder with the
“Agilent”-labeled barcode facing upside down. In this orientation, the
“active side” containing the microarray is protected from potential damage
by fingerprints and other elements. Once securely placed, the numeric
barcode, “non-active side” of the slide is visible.

Figure 15 depicts how the Agilent microarray scanner reads the microarrays
and how this relates to the “microarray design files” that Agilent generates
during the manufacturing process of its in situ-synthesized oligonucleotide
microarrays. Thus, if you have a scanner that reads microarrays from the
“front side” of the glass slide, the collection of microarray data points will be
different in relation to the “microarray design files” supplied with the Agilent
oligo microarray kit you purchased. Therefore, please take a moment to
become familiar with the microarray layouts for each of the Agilent oligo
microarrays and the layout information as it pertains to scanning using a
“front side” scanner.
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Non-Agilent Front Side Microarray Scanners

When scanning Agilent oligo microarray slides, the user must determine:

e If the scanner images the microarrays by reading them on the “front
side” of the glass slide (“Agilent”-labeled barcode side of the slide) and

¢ If the microarray image produced by the non-Agilent scanner is
oriented in a “portrait” or “landscape” mode, and “Agilent”-labeled
barcode is on the left-side, right-side, up or down, as viewed as an
image in the imaging software (see Figure 16).

This changes the feature numbering and location as it relates to the
“microarray design files” found on the disk in each Agilent oligo
microarray Kit.
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Agilent Microarray Layout and Orientation

Front side
barcode up
(portrait)
L J
r hl
Front side Front side
barcode left barcode right
(landscape) o (landscape)
Front side
barcode down
(portrait)

Figure 16  Microarray slide orientation
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Array/Sample tracking on a 8-pack array slide

Use the form below to make notes to track your samples on a 8-pack array
slide. The Agilent scanner scans through the bottom surface of the array, so if
the gasket is loaded “as a book” (top row first and left to right), the array

orientation will come out in the same way.

Arrays
Array 1_1 Array 1_2 Array 1_3 Array 1_4

Sample: Sample: Sample: Sample:
L
A
B
E
L Sample: Sample: Sample: Sample:

Array 2_1 Array 2_2 Array 2_3 Array 2_4

Barcode Number
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Agilent Information Assets Access Agreement

I. PURPOSE

1 Agilent Technologies (“Agilent”) and User have entered into a business
relationship that would be fostered by granting User access to certain
of Agilent's Information Assets (“Assets”). Accordingly, User and Agilent
have entered into this Information Assets Access Agreement (IAAA) in
order to protect the confidentiality, integrity, availability, and physical
security of Agilent 's various information assets and to prevent
unauthorized individuals from gaining access to Agilent's various
networks, computers and information assets. Access is granted only for
the purposes of fulfilling the specific business relationship between
User and Agilent which gives rise to this agreement. The use of Agilent
information for any other purpose is expressly prohibited.

2 User and Agilent acknowledge that they have entered into other
agreements or contractual arrangements defining their business
relationship. These agreements are independent of this IAAA and in the
event of any conflict between them, the terms of this IAAA shall prevail
only as applies to this JAAA.

II. PHYSICAL SECURITY OF AGILENT INFORMATION ASSETS

1 User agrees to exercise no less than a reasonable degree of care to
ensure that access to Agilent's information assets is limited solely to its
authorized personnel who have been granted access by Agilent to
specific information assets. Under no circumstance may User allow an
individual to access an Agilent information asset without a properly
authorized grant of access from Agilent for that individual and for that
information asset. Only those Users provided access to the information
assets via an Agilent authorized authentication procedure may access
the information assets.

USE OF AGILENT INFORMATION ASSETS FOR OTHER THAN
INTERNAL USE AND/OR FOR COMMERCIAL PURPOSES WITHOUT
AGILENT'S PRIOR WRITTEN CONSENT IS EXPRESSLY PROHIBITED.

Use of any other computer systems or Agilent information assets is
expressly prohibited in the absence of written authorization from
Agilent. This prohibition applies even when an information resource
which User is authorized to access serves as a gateway to other
information resources outside of User's scope of authorization. These
prohibitions apply even if Agilent fails to implement physical or logical
security measures which prevent the access.
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USE OF AGILENT INFORMATION ASSETS BY OTHER INDIVIDUALS
NOT AUTHORIZED IN WRITING OR VIA ELECTRONIC MAIL BY
AGILENT IS EXPRESSLY PROHIBITED.

2 Without limiting the foregoing, User specifically agrees to:

a Control physical access to passwords, tokens, log-on scripts and
other such hardware/data as may be used to access Assets. No
passwords, security tokens or other authentication information may
be shared between individuals without written approval from Agilent.
User agrees to access Agilent information resources only from the
specific locations that have been approved for access by Agilent
management. For access outside of Agilent premises, Agilent will
specify in writing or via electronic mail the specific network
connections that will be used to access Agilent information assets.

b Periodically review personnel granted access under this IAAA to
insure that access remains necessary to the underlying business
purpose.

¢ Coordinate within User's organization the proper implementation of
this agreement and ensure that all the rules and obligations
contained in this agreement are strictly followed and complied with
at all times in User's organization.

3 In its sole discretion and without incurring liability, Agilent reserves the
right to deny, limit, or terminate access of any person or firm or access
to any system(s) without notice or cause.

III. PROTECTION OF ELECTRONIC CONFIDENTIAL INFORMATION

1 User and its employees or agents (collectively referred to as User,
unless the context requires otherwise) shall not disclose any Electronic
Confidential Information (ECI) received from Agilent to any other
person without the express prior written consent of Agilent. User shall
use such information only for purposes necessary for its relationship
with Agilent or consistent with this Agreement, and shall use
reasonable care to avoid unauthorized disclosure or use of such ECI.

2 Electronic Confidential Information obtained from Assets shall be
defined as any information marked as confidential or proprietary, and
any information, while not marked as confidential or proprietary, which
is of such a nature that a reasonable person would believe it to be
confidential or proprietary. Agilent shall take reasonable precautions to
prevent the User from receiving unmarked confidential or proprietary
information. However, User acknowledges that due to the nature of
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electronic systems, such information may be delivered to User
inadvertently or with an inadvertent omission of the markings. If User
receives information that a reasonable person would believe to be
confidential or proprietary, User shall have an affirmative duty to
inquire of Agilent as to the confidentiality of the information before
treating it as non-confidential information.

3 This Agreement imposes no obligation upon User with respect to any
confidential or proprietary information disclosed to User pursuant to
the terms of a separately executed Confidential Disclosure Agreement
or other contractual arrangement specifically addressing such
information. The obligations of the parties with respect to such
information shall be governed solely by the terms of such Confidential
Disclosure Agreement or contractual arrangement.

IV. LIMITED RIGHTS TO PUBLISH IN PEER-REVIEWED JOURNALS
ONLY

1 User may publish the following only in peer-reviewed scientific journals
[“Publication.”]

2 User may publish only fifty (50) probe-sequences in any single
Publication.

3 User or its permitted publisher, including without limitation the
investigator, scientists, and/or researchers, hereby agrees to add a
statement in a prominent location within such publication; provided
User publishes the specific design file number that Agilent shall
provide, stating the following: ANY PUBLICATION OR PUBLIC
DISCLOSURE OF OLIGONUCLEOTIDE SEQUENCES FOR USE WITH
MICROARRAYS MAY ONLY BE REPRODUCED OR MANUFACTURED
FOR YOU BY AGILENT TECHNOLOGIES, INC. BY REFERENCING THE
CATALOG MICROARRAY PRODUCT NUMBER OR THE CUSTOM
MICROARRAY DESIGN IDENTIFICATION NUMBER SUPPLIED BY YOU
BY AGILENT.

4 User hereby grants Agilent all rights to reproduce products based upon
User's Confidential Information for Third Parties requesting such
Products.
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V. ADMINISTRATION

1 Audit: Upon reasonable notice, User shall allow Agilent access to such
information as may reasonably be necessary to ascertain User's
compliance with the obligations contained herein.

2 Loss/Damage: User shall indemnify and hold Agilent harmless from all
loss, damage, cost and expense arising from User's breach of this
Agreement.

3 User warrants and represents that each employee or agent of User who
is granted access under this agreement has been informed of the
obligations contained herein and has agreed in writing to be bound by
them. Without limiting the foregoing, each individual must be informed
of the specific information assets he is authorized to access and the
duty to refrain from accessing other information assets outside his
scope of authorization even if logical or physical security measures are
not in place to prevent the access.

VI. MISCELLANEOUS

1 This Agreement is made under and shall be construed according to the
laws of the State or Country in which the signing Agilent entity is
located.

2 This Agreement constitutes the entire and exclusive agreement of the
parties regarding the subject matter of this Agreement. This Agreement
may not be varied.
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